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Introduzione all’editor schemi elettrici di
KiCad
Descrizione
L’editor degli schemi di KiCad è un software distribuito come parte della suite KiCad, e disponibile per i
seguenti sistemi operativi:

Linux

Apple macOS

Windows

Indipendentemente dal sistema operativo, tutti i file KiCad sono 100% compatibili da un sistema all’altro.

L’editor degli schemi è un’applicazione integrata dove tutte le funzioni di disegno, controllo, disposizione,

gestione librerie e accesso al software di progettazione di circuiti stampati sono svolte all’interno dell’editor
stesso.

L’editor degli schemi elettrici di KiCad è stato concepito per cooperare il programma per la progettazione di
circuiti stampati della suite di KiCad. Esso può anche esportare file di netlist, che descrivono le connessioni

elettriche dello schema usabili da altri software.

L’editor degli schemi include un editor di librerie di simboli, che può creare e modificare simboli e gestire
librerie. Esso integra le seguenti funzioni, aggiuntive ma essenziali, necessarie in ogni moderno software di
elaborazione schemi elettrici:

Controllo regole di progettazione (ERC) per il controllo automatico di connessioni errate o sconnesse

Esportazione di file del disegno dello schema in molti formati (Postscript, PDF, HPGL e SVG).

Generazione della distinta materiali (tramite script Python o XSLT, che consentono di modellarla in molti
formati).

L’editor degli schemi supporta schemi multifoglio in diversi modi:

Gerarchie piatte (i fogli degli schemi non sono esplicitamente connessi ad uno schema principale).

Gerarchie semplici (ogni foglio di schema elettrico viene usato solo una volta).

Gerarchie complesse (alcuni fogli di schemi elettrici sono usati più di una volta).

Gli schemi gerarchici sono descritti in dettaglio più avanti nel manuale.

Configurazione iniziale
Quando l’editor degli schemi viene eseguito per la prima volta, se il file della tabella librerie di simboli
globale sym-lib-table  non si trova nella cartella di configurazione di KiCad, KiCad chiederà come creare

questo file:
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Si consiglia la prima opzione (Copia tabella libreria simboli globale predefinita (consigliato)). La tabella
librerie impronte predefinita include molte delle librerie impronte standard che sono installate assieme a
KiCad.

Se questa opzione è disabilitata, KiCad non è stato in grado di trovare la tabella della libreria di simboli

globale predefinita. Questo probabilmente significa che non sono state installate le librerie di simboli
standard con KiCad, o che non sono installate dove KiCad si aspetta di trovarle. Su alcuni sistemi le librerie
KiCad sono installate come pacchetto separato.

Se si ha installato le librerie di simboli standard di KiCad e vuole usarle, ma la prima opzione è

disabilitata, selezionare la seconda opzione e andare al file sym-lib-table  nella cartella in cui sono state
installate le librerie di KiCad.

Se si ha già una tabella librerie di simboli personalizzata che si vorrebbe usare, selezionare la seconda
opzione e cercare il proprio file sym-lib-table .

Se si vuole costruire una nuova tabella librerie di simboli da zero, selezionare la terza opzione.

La gestione delle librerie di simboli viene descritta in maggior dettaglio più avanti.
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Interfaccia utente dell’editor degli schemi elettrici

L’interfaccia utente principale dell’editor degli schemi elettrici è mostrata sopra. Il centro contiene l’area di
modifica principale, che è circondata da:

Barre degli strumenti principali (gestione dei file, strumenti di zoom, strumenti di modifica)

Barra degli strumenti di sinistra (opzioni di visualizzazione)

Pannello dei messaggi e barra di stato in basso

Pannello di destra (strumenti di disegno e progettazione)

Navigazione nell’area di lavoro
L’area di lavoro mostra lo schema in fase di progettazione. È possibile traslare la vista e fare lo zoom su
diverse parti dello schema e aprire qualsiasi foglio dello schema nel progetto.

By default, dragging with the middle or right mouse button will pan the canvas view and scrolling the mouse

wheel will zoom the view in or out. You can change this behavior in the Mouse and Touchpad section of the
preferences (see Configuration and Customization for details).
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Several other zoom tools are available in the top toolbar:

 zooms in on the center of the viewport.

 zooms out from the center of the viewport.

 zooms to fit the frame around the drawing sheet.

 zooms to fit the items within the drawing sheet.

 allows you to draw a box to determine the zoomed area.

The cursor’s current position is displayed at the bottom of the window (X and Y), along with the current
zoom factor (Z), the cursor’s relative position (dx, dy, and dist), the grid setting, and the display units.

Le coordinate relative possono essere azzerate premendo . È utile per effettuare misure tra due
punti o per allineare oggetti.

Comandi da tastiera
The +  shortcut displays the current hotkey list. The default hotkey list is included in the Actions

Reference section of the manual.

The hotkeys described in this manual use the key labels that appear on a standard PC keyboard. On an Apple
keyboard layout, use the  key in place of , and the  key in place of .

Molte azioni non hanno tasti comando assegnati per impostazione predefinita, ma i tasti comando possono

essere assegnati o ridefiniti utilizzando l’editor di tasti comando (Preferenze → Preferenze…​ → Tasti
comando ).

NOTE
Many of the actions available through hotkeys are also available in context menus. To
access the context menu, right-click in the editing canvas. Different actions will be
available depending on what is selected or what tool is active.

I comandi da tastiera sono memorizzati nel file user.hotkeys  nella cartella di configurazione di KiCad. La
posizione cambia a seconda della piattaforma:

Windows: %APPDATA%\kicad\6.0\user.hotkeys

Linux: ~/.config/kicad/6.0/user.hotkeys

macOS: ~/Library/Preferences/kicad/6.0/user.hotkeys

KiCad può importare le impostazioni dei tasti comando da un file user.hotkeys  utilizzando il pulsante

Importa tasti comando nell’editor di tasti comando.

Operazioni e selezione col mouse
Selecting items in the editing canvas is done with the left mouse button. Single-clicking on an object will
select it and dragging will perform a box selection. A box selection from left to right will only select items
that are fully inside the box. A box selection from right to left will select any items that touch the box. A left-

to-right selection box is drawn in yellow, with a cursor that indicates exclusive selection, and a right-to-left
selection box is drawn in blue with a cursor that indicates inclusive selection.

Spazio

Ctrl F1

Cmd Ctrl Option Alt
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The selection action can be modified by holding modifier keys while clicking or dragging. The following
modifier keys apply when clicking to select single items:

Modifier Keys
(Windows)

Modifier Keys
(Linux)

Modifier Keys
(macOS)

Selection Effect

Add the item to the existing selection.

+ + + Remove the item from the existing
selection.

long click long click or long click or Clarify selection from a pop-up menu.

Highlight the net of the selected copper
item.

The following modifier keys apply when dragging to perform a box selection:

Modifier Keys
(Windows)

Modifier Keys
(Linux)

Modifier Keys
(macOS)

Selection Effect

 or  or  or Add item(s) to the existing selection.

+ + + Remove item(s) from the existing
selection.

Selecting an object displays information about the object in the message panel at the bottom of the window.
Double-clicking an object opens a window to edit the object’s properties.

Pressing  will always cancel the current tool or operation and return to the selection tool. Pressing 

while the selection tool is active will clear the current selection.

Controlli di visualizzazione della barra strumenti a sinistra
La barra strumenti a sinistra fornisce le opzioni di visualizzazione degli elementi nell’editor degli schemi
elettrici.

Shift Shift Shift

Ctrl Shift Ctrl Shift Cmd Shift

Alt

Option

Ctrl Ctrl Cmd

Shift Ctrl Shift Ctrl Shift Ctrl

Ctrl Shift Ctrl Shift Cmd Shift

Esc Esc
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Commuta la visibilità griglia.

Nota: per impostazione predefinita, nascondendo la griglia si disabiliterà il magnetismo della
griglia.
Questo comportamento è modificabile nella sezione Opzioni di visualizzazione delle
preferenze.

Mostra/ inserimento coordinate e dimensioni in pollici, mils, o millimetri.

Seleziona la forma del puntatore (pieno schermo/piccolo).

Commuta la visibilità dei pin "invisibili".

Commuta tra angoli liberi e orizzontale/verticale per il piazzamento di nuovi
fili, bus e linee
grafiche.
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Creazione e modifica di schemi elettrici
Introduzione
Uno schema elettrico progettato con KiCad è più di una semplice rappresentazione grafica di un dispositivo
elettronico. Esso normalmente è il punto di ingresso di una catena di sviluppo che permette:

Il controllo di validità rispetto ad una serie di regole (Controllo Regole Elettriche (ERC)) per il

rilevamento di errori e omissioni.

Generazione automatica della DIBA.

La generazione di una netlist per software di simulazione tipo SPICE.

Definizione di un circuito per il trasferimento delle informazioni nella progettazione del circuito

stampato.

Uno schema elettrico consiste principalmente di simboli, fili, etichette, giunzioni, porte bus e pin di potenza.
Per chiarezza, negli schemi elettrici, è possibile inserire elementi puramente grafici come elementi bus,
commenti, e polilinee.

I simboli vengono aggiunti allo schema dalle librerie di simboli. Dopo aver creato lo schema, l’insieme di

connessioni e impronte viene importato nell’editor dei circuiti stampati per progettare la scheda.

Gli schemi possono essere contenuti in un unico foglio o suddivisi in più fogli. In KiCad, gli schemi a più fogli
sono organizzati gerarchicamente, con un foglio principale e uno o più fogli secondari. Ogni foglio è il

proprio file .kicad_sch  ed è esso stesso uno schema completo di KiCad. L’utilizzo degli schemi gerarchici è
descritto nel capitolo schemi gerarchici.

Operazioni di modifica degli schemi elettrici
Schematic editing tools are located in the right toolbar. When a tool is activated, it stays active until a
different tool is selected or the tool is canceled with the  key. The selection tool is always activated

when any other tool is canceled.

Strumento di selezione (lo strumento predefinito)

Evidenzia una net contrassegnando i suoi fili e le etichette della net con un colore diverso.
Se è
aperto anche l’editor del C.S. allora verrà anche evidenziato il rame corrispondente alla
net
selezionata. L’evidenziazione della net può essere cancellata facendo clic con
lo strumento di
evidenziazione in uno spazio vuoto o utilizzando il tasto comando
Cancella evidenziazione
net ( ).

Visualizza la finestra di dialogo di selezione dei simboli per inserire un nuovo simbolo.

Visualizza la finestra di dialogo di selezione del simbolo di potenza per inserire un nuovo
simbolo di potenza.

Disegna un filo.

Disegna un bus.

Esc

~
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Disegna i punti di ingresso da filo a bus. Questi elementi sono solo grafici e non creano
una
connessione, quindi non dovrebbero essere usati per collegare i fili assieme.

Posiziona un contrassegno "Nessuna connessione". Queste segnalazioni dovrebbero essere
posizionate sui pin dei simboli che
sono pensati per essere lasciati scollegati. I flag "Nessuna
connessione" indicano al controllo regole elettriche
che il pin è intenzionalmente scollegato e
non un errore.

Posiziona un incrocio. Questo collega due fili incrociati o un filo e un pin, che
a volte può
essere ambiguo senza una giunzione (ad esempio se un’estremità del filo o un pin è
non
direttamente collegato ad un’altra estremità del filo).

Posiziona un’etichetta locale. Le etichette locali collegano gli elementi che si trovano nello
stesso foglio.
Per le connessioni tra due fogli diversi, utilizzare etichette globali o gerarchiche.

Posiziona un’etichetta globale. Tutte le etichette globali con lo stesso nome sono collegate,
anche
quando si trovano su fogli diversi.

Posiziona un’etichetta gerarchica. Le etichette gerarchiche vengono utilizzate per creare una
connessione
tra un foglio secondario e il suo foglio genitore. Consultare la sezione
Schemi
gerarchici per ulteriori informazioni
su etichette, fogli e pin gerarchici.

Posiziona un sottofoglio gerarchico. È necessario specificare il nome del file per questo
sottofoglio.

Importa un segnaposto gerarchico da un sottofoglio. Questo comando può essere eseguito
solo su
sottofogli gerarchici. Creerà pin gerarchici corrispondenti ad etichette gerarchiche
posizionate nel sottofoglio di destinazione.

Disegna linee.

Nota: Le linee sono oggetti grafici e non sono la stessa cosa dei fili
posizionati con lo
strumento Filo. Non collegano nulla.

Inserisce un commento di testo.

Posiziona un’immagine bitmap.

Elimina gli elementi cliccati.

Griglie
Nell’editor degli schemi il puntatore si sposta sempre sopra una griglia. La griglia può essere personalizzata:

La dimensione è modificabile usando il tasto destro del mouse o usando Visualizza → Proprietà
griglia…​.

I colori possono essere modificati tramite la scheda Colori presente nella finestra di dialogo delle
Preferenze (menu Preferenze → Opzioni generali).

La visibilità può essere accesa/spenta usando il pulsante corrispondente nella barra strumenti di sinistra.

La dimensione predefinita della griglia è 50 mils (0.050") o 1,27 millimetri.
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Questa è la griglia raccomandata per piazzare simboli e fili in uno schema elettrico, e per piazzare piedini
durante la progettazione di un simbolo nell’editor dei simboli.

NOTE

Wires connect with other wires or pins only if their ends coincide
exactly. Therefore it is
very important to keep symbol pins and wires
aligned to the grid. It is recommended to
always use a 50 mil grid when
 placing symbols and drawing wires because the KiCad
standard symbol
library and all libraries that follow its style also use a 50 mil grid.
Using a
grid size other than 50 mil will result in schematics without
proper connectivity!

È possibile usare anche griglie più piccole, ma queste servono solo per il testo e la grafica dei simboli e non è
consigliato per posizionarvi pin e fili.

NOTE Symbols, wires, and other elements that are not aligned to the grid can be
snapped back to
the grid by selecting them, right clicking, and clicking
Align Elements to Grid.

Magnetismo
Schematic elements such as symbols, wires, text, and graphic lines are snapped to the grid when moving,

dragging, and drawing them. Additionally, the wire tool snaps to pins even when grid snapping is disabled.
Both grid and pin snapping can be disabled while moving the mouse by using the modifier keys in the table
below.

NOTE Su tastiere Apple, usare il tasto  al posto di .

Modifier Key Effect

Disable grid snapping.

Disable snapping wires to pins.

Lavorare con i simboli

Piazzamento simboli
Per caricare un simbolo nello schema elettrico si può usare l’icona . Una finestra di dialogo permette di

battere il nome del simbolo da caricare.

Cmd Ctrl

Ctrl

Shift
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La finestra di dialogo di scelta del simbolo filtrerà i simboli per nome, parolachiave, e descrizione secondo
quanto si inserirà nel campo di ricerca.

Alcuni filtri avanzati sono disponibili:

Caratteri jolly: usare i caratteri ?  e *  rispettivamente per significare "qualsiasi carattere singolo" e

"qualsiasi carattere in qualsiasi numero, anche zero".

Paia di chiavi-valore: se la descrizione di un componente di libreria o parola chiave contiene
 un

marcatore nel formato "chiave:123", si può verificarne la corrispondenza relativa battendo
"chiave>123"
(maggiore di), "chiave<123" (minore di), ecc. I numeri possono includere
 uno dei seguenti suffissi
indipendenti da maiuscole o minuscole:

p n u m k meg g t

10 10 10 10 10 10 10 10

ki mi gi ti

2 2 2 2

Espressioni regolari: se si ha familiarità con le espressioni regolari,
si possono usare anch’esse. Il tipo di
espressione regolare usato è di
 stile espressione
 regolare avanzato dei wxWidgets, che è simile alle

-12 -9 -6 -3 3 6 9 12

10 20 30 40

http://docs.wxwidgets.org/3.0/overview_resyntax.html
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espressioni regolari
Perl.

If the symbol specifies a default footprint, this footprint will be previewed in the lower right. If the symbol
includes footprint filters, alternate footprints that satisfy the footprint filters can be selected in the
footprint dropdown menu at right.

Dopo aver selezionato un simbolo da posizionare, il simbolo verrà attaccato al cursore. Facendo clic con il
pulsante sinistro del mouse sulla posizione desiderata nello schema, il simbolo viene inserito nello schema.
Prima di posizionare il simbolo nello schema elettrico, è possibile ruotarlo, renderlo speculare e
modificarne i campi, usando i tasti comando o il menu contestuale del tasto destro. Queste azioni possono

essere eseguite anche dopo il posizionamento.

Ecco un simbolo durante il piazzamento:

Se l’opzione Posiziona copie ripetute è selezionata, dopo aver posizionato un simbolo, KiCad inizierà a

posizionare un’altra copia del simbolo. Questo processo continua finché l’utente non preme .Esc
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Per i simboli con più unità, se l’opzione Posiziona tutte le unità è selezionata, dopo aver posizionato il
simbolo KiCad inizierà a posizionare l’unità successiva nel simbolo. Ciò continuerà fino a quando l’ultima

unità sarà stata posizionata o sino a quando l’utente premerà .

Piazzamento porte di potenza
Un simbolo di porta di potenza è un simbolo che rappresenta una connessione ad un collegamento (net) di
potenza. I simboli sono raggruppati nella libreria power , in modo tale che possano essere piazzati usando la
finestra di selezione dei simboli. Comunque, dato che il piazzamento di questi simboli è frequente, è

disponibile anche lo strumento . Questo strumento è del tutto simile all’inserimento simboli, eccetto per

il fatto che la ricerca viene effettuata già direttamente nella libreria power  e in ogni altra libreria contenente
simboli di potenza.

Spostamento simboli
Symbols can be moved using the Move ( ) or Drag ( ) tools. These tools act on the selected symbol, or if
no symbol is selected they act on the symbol under the cursor.

The Move tool moves the symbol itself without maintaining wired connections to the symbol pins.

The Drag tool moves the symbol without breaking wired connections to its pins, and therefore moves the
connected wires as well.

You can also Drag symbols by clicking and dragging them with the mouse, depending on the Left button
drag gesture setting in the Mouse and Touchpad section of Preferences.

Symbols can also be rotated ( ) or mirrored in the X ( ) or Y ( ) directions.

Modifica delle proprietà del simbolo
A symbol’s fields can be edited in the symbol’s Properties window. Open the Symbol Properties window for a
symbol with the  hotkey or by double-clicking on the symbol.

Esc

M G

R X Y

E
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The Symbol Properties window displays all the fields of a symbol in a table. New fields can be added, and
existing fields can be deleted, edited, reordered, moved, or resized.

Ogni campo può essere visibile o nascosto, e mostrato orizzontalmente o verticalmente. La posizione
mostrata è sempre indicata per un simbolo mostrato normalmente (nessuna rotazione o ribaltamento
speculare) ed è relativa al punto di ancoraggio del simbolo.

The position and orientation properties of each field may be hidden in this dialog. They can be shown by

right-clicking on the column header of the fields table and enabling the "Orientation", "X Position", and/or "Y
Position" columns. Other columns can be shown or hidden as desired.

The "Update Symbol from Library…​" button is used to update the schematic’s copy of the symbol to match
the copy in the library. The "Change Symbol…​" button is used to swap the current symbol to a different

symbol in the library.

"Edit Symbol…​" opens the Symbol Editor to edit the copy of the symbol in the schematic. Note that the
original symbol in the library will not be modified. The "Edit Library Symbol…​" button opens the Symbol
Editor to edit the original symbol in the library. In this case, the symbol in the schematic will not be modified

until the user clicks the "Update Symbol from Library…​" button.

Modifica individuale dei campi del simbolo
An individual symbol text field can be edited directly with the  hotkey (with a field selected instead of a
symbol) or by double-clicking on the field.

Some symbol fields have their own hotkey to edit them directly. With the symbol selected, the Reference,
Value, and Footprint fields can be edited with the , , or  hotkeys, respectively.

The options in this dialog are the same as those in the full Symbol Properties dialog, but are specific to a
single field.

Symbol fields can be automatically moved to an appropriate location with the Autoplace Fields action (select
a symbol and press ). Field autoplacement is configurable in the Schematic Editor’s Editing Options,
including a setting to always autoplace fields.

E

U V F

O
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Tabella campi del simbolo
The Symbol Fields Table allows you to view and modify field values for all symbols in a spreadsheet
interface. You can open the Symbol Fields Table with the  button.

Cells are navigated with the arrow keys, or with  / +  to move right / left and  / +
 to move down / up, respectively.

A range of cells can be selected by clicking and dragging. The whole range of selected cells will be copied (
+ ) or pasted into ( + ) on a copy or paste action. Copying a range of cells from the table can be

useful for creating a BOM. More details of copying and pasting cells are described below.

Any symbol field can be shown or hidden using the Show checkboxes on the left, or by right-clicking on the
header of the table. New symbol fields can be added using the Add Field…​ button.

Similar symbols can optionally be grouped by any symbol field using the Group By checkboxes. Grouped
symbols are shown in a single row in the table. The grouped row can be expanded to show the individual
symbols by clicking the arrow at the left of the row.

Tab Shift Tab Enter Shift

Enter

Ctrl C Ctrl V
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Trucchi per semplificare lo riempimento dei campi
Esistono diversi metodi speciali di copia/incolla nel foglio di calcolo per incollare i valori in regioni più
grandi, comprese le celle incollate con incremento automatico. Queste funzionalità possono essere utili

quando si incollano valori condivisi in più simboli.

Questi metodi sono illustrati sotto.

1. Copia ( + ) 2. Selezione celle obiettivo 3. Incolla ( + )

NOTE Queste tecniche sono disponibili anche in altre finestre di dialogo con elementi di
controllo a griglia.

Ctrl C Ctrl V
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Reference Designators and Symbol Annotation
Reference designators are unique identifiers for components in a design. They are often printed on a PCB
and in assembly diagrams, and allow you to match symbols in a schematic to the corresponding components

on a board.

In KiCad, reference designators consist of a letter indicating the type of component ( R  for resistor, C  for
capacitor, U  for IC, etc.) followed by a number. If the symbol has multiple units then the reference
designator will also have a trailing letter indicating the unit. Symbols that don’t have a reference designator

set have a ?  character instead of the number. Reference designators must be unique.

Reference designators can set manually by editing a symbol’s reference designator field, or automatically
using the Annotation tool.

NOTE The process of setting a symbol’s reference designator is called annotation.

Strumento di annotazione
Lo strumento di annotazione assegna automaticamente i riferimenti a simboli nello schema. Per eseguire lo

strumento di annotazione fare clic sull’icona  nella barra strumenti in alto.
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The tool provides several options to control how symbols are annotated.

Scope: Selects whether annotation is applied to the entire schematic, to only
the current sheet, or to only the
selected symbols.

Options: Selects whether annotation should apply to all symbols and reset
*existing reference designators,

or apply only to unannotated symbols.

Order: Chooses the direction of numbering. If symbols are sorted by X
position, all symbols on the left side
of a schematic sheet will be lower
numbered than symbols on the right side of the sheet. If symbols are
sorted by Y
position, all symbols on the top of a sheet will be lower numbered than symbols
at the bottom of

the sheet.

Numbering: Selects the starting point for numbering reference designators. The
 lowest unused number
above the starting point is picked for each reference
 designator. The starting point can be an arbitrary
number (typically zero), or
it can be the sheet number multiplied by 100 or 1000 so that each part’s
reference

designator corresponds to the schematic page it is on.

The Clear Annotation button clears all reference designators in the selected scope.
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Annotation messages can be filtered with the checkboxes at the bottom or saved to a report using the
Save…​ button.

Connessioni elettriche
There are two primary ways to establish connections: wires and labels. Both are shown in the schematic
below.

Connections can also be made with buses and with implicit connections via hidden power pins.

This section will also discuss two special types of symbols that can be added with the "Power port" button on
the right toolbar:

Porte di potenza: simboli per collegare fili a net di potenza o massa.

PWR_FLAG: a specific symbol for indicating that a net is powered when it is
not connected to a power

output pin (for example, a power net that is supplied
by an off-board connector).

Connessioni etichetta
Le etichette vengono utilizzate per assegnare nomi di net a fili e pin. I fili con lo stesso nome di net sono

considerati connessi. Una net può avere un solo nome. Se due etichette diverse vengono posizionate sulla
stessa rete, verrà generata una violazione ERC. Nella netlist verrà utilizzato solo uno dei nomi di net. Il
nome della net finale è determinato in base alle regole descritte di seguito.

There are three types of labels, each with a different connection scope.
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Local labels, also referred to simply as labels, only make connections
within a sheet. Add a local label

with the
  button in the right
toolbar.

Global labels make connections anywhere in a schematic, regardless of sheet.
Add a global label with the

 button in the right
toolbar.

Hierarchical labels connect to hierarchical sheet pins and are used in
 hierarchical schematics for

connecting child
sheets to their parent sheet. Add a hierarchical label with the
 
button in the right

toolbar.

NOTE Labels that have the same name will connect, regardless of the label type,
if they are in the
same sheet.

After using the appropriate button or hotkey to create a label, the Label Properties dialog appears.

The Label field sets the label’s text, which determines the net that the label assigns to its attached wire.
Label text supports markup for overbars, subscripts, etc., as well as variable substitution. Use the Syntax
help link in the dialog for a summary.

Justification sets the position of the label’s connection point relative to
the label’s text. For example, when
Align right is selected the connection
point will be to the right of the text.

Text size and Style control the appearance of the label’s text. Shape
 controls the shape of the outline
around the label; this is purely visual and
has no electrical consequence. Local labels do not have an outline,

and
therefore do not have Shape options.

NOTE Global labels have additional settings to control margins around the label text in the
Schematic Setup dialog.

After accepting the label properties, the label is attached to the cursor for placement. The connection point

for a label is the small square in the corner of the label. The square disappears when the label is connected to
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a wire or the end of a pin.

The connection point’s position relative to the label text can be changed by choosing a different label
orientation in the label’s properties, or by mirroring/rotating the label.

The Label Properties dialog can be accessed at any time by selecting a label and using the  hotkey, double-

clicking on the label, or with Properties…​ in the right-click context menu.

Connessioni filo
Per stabilire una connessione, un segmento di filo deve essere connesso ai suoi capi ad un altro segmento o a
un piedino. Solo le estremità dei fili creano connessioni; se un filo attraversa il centro di un altro filo, non
verrà effettuata una connessione.

Unconnected wire ends have a small square that indicates the connection point. The square disappears when
a connection is made to the wire end. Unconnected pins have a circle, which also disappears when a
connection is made.

NOTE

Wires connect with other wires or pins only if their ends coincide
exactly. Therefore it is
important to keep symbol pins and wires aligned
to the grid. It is recommended to always
use a 50 mil grid when placing
symbols and drawing wires because the KiCad standard
symbol library and
all libraries that follow its style also use a 50 mil grid.

NOTE Symbols, wires, and other elements that are not aligned to the grid can be
snapped back to
the grid by selecting them, right clicking, and selecting
Align Elements to Grid.

Disegno e modifica fili
To begin connecting elements with wire, use the Wire tool  in the right toolbar ( ). Wires can also be

automatically started by clicking on an unconnected symbol pin or wire end.

Wires can be moved using the Move ( ) or Drag ( ) tools. As with symbols, the Move tool moves only the
selected segment, without maintaining existing connections to other segments. The Drag tool maintains

existing connections.

If a segment is selected or the cursor is over the middle of a wire, the move/drag action will move the entire
segment. If the cursor is over a corner or wire end, the move/drag action will act on one end of the segment.

Giunzioni di fili
I fili che si incrociano non sono implicitamente connessi. È necessario collegarli assieme esplicitamente con

un punto di giunzione se si vuole stabilire una connessione (pulsante  nella barra strumenti a destra). I

punti di giunzione verranno aggiunti automaticamente ai fili che cominciano o finiscono su altri fili esistenti.

E

w

M G
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I punti di giunzione sono utilizzati nella figura dello schema precedente sui fili collegati ai pin 18, 19, 20, 21,
22 e 23 di P1 .

Connessioni bus
I bus sono un modo per raggruppare segnali in relazione tra loro in uno schema elettrico, in modo da

semplificare i progetti complessi. I bus possono essere disegnati come i fili usando lo strumento bus , e i

loro nomi vengono assegnati usando le etichette allo stesso modo di come si fa con i fili dei segnali.

Nello schema elettrico seguente, molti piedini sono connessi a dei bus, cioè le linee spesse blu al centro.

Membri di bus
There are two types of bus in KiCad 6.0 and later: vector buses and group buses.

Un bus vettoriale è un insieme di segnali che cominciano con un prefisso comune e finiscono con un
numero. I bus vettoriali hanno nome nella forma <PREFISSO>[M..N]  dove PREFISSO  è un qualsiasi nome di
segnale valido, M  è il primo numero del suffisso, e N  è l’ultimo numero del suffisso. Per esempio, il bus
DATA[0..7]  contiene i segnali DATA0 , DATA1 , e così via fino a DATA7 . Non importa in quale ordine M  ed N

vengono specificati, ma entrambi devono essere positivi.

Un bus di gruppo è un insieme di uno o più segnali e/o bus vettoriali. I bus di gruppo possono essere usati
per tenere assieme segnali correlati anche quando questi hanno nomi diversi. I bus di gruppo usano una
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sintassi etichetta speciale:

<NOME_OPZIONALE>{SEGNALE1 SEGNALE2 SEGNALE3}

I membri del gruppo sono elencati dentro parentesi graffe ( {} ) separati da spazi. Il nome opzionale del
gruppo va prima della prima parentesi. Se il bus di gruppo è anonimo, i collegamenti risultanti sul C.S.
saranno semplicemente i nomi dei segnali dentro il gruppo. Se il bus di gruppo possiede un nome, i
collegamenti risultanti avranno il nome come prefisso, con un punto ( . ) di separazione tra il prefisso e il

nome del segnale.

Per esempio, il bus {SCL SDA}  ha due segnali membri, e nella netlist questi segnali saranno SCL  e SDA . Il
bus USB1{DP DM}  genererà collegamenti chiamati USB1.DP  e USB1.DM . Per progetti con bus grandi, ripetuti
tra diversi circuiti simili, l’uso di questa tecnica può far risparmiare tempo.

I bus di gruppo possono contenere anche bus vettoriali. Per esempio, il bus MEMORY{A[7..0] D[7..0] OE
WE}  contiene sia bus vettoriali che segnali normali, il ché porterà a del collegamenti del tipo MEMORY.A7  e
MEMORY.OE  sul C. S. .

I fili di bus si possono disegnare e collegare allo stesso modo dei fili dei segnali, compreso l’uso di giunzioni

per creare connessioni tra fili che si incrociano. Come per i segnali, i bus non possono avere più di un nome 
— se due etichette in conflitto sono associate allo stesso bus, verrà generato un errore di controllo regole
elettriche (ERC).

Connessioni tra membri di bus
Piedini connessi tra gli stessi membri di un bus devono essere connessi da etichette. Non è possibile
connettere un piedino direttamente ad un bus; questo tipo di connessione sarà ignorata da KiCad.

Nell’esempio sopra, le connessioni vengono effettuate dalle etichette piazzate sui fili connessi ai piedini. Le
voci di bus (segmenti di filo a 45 gradi) sono solo elementi grafici, e non sono necessarie per formare
connessioni logiche.

In effetti, usando il comando di ripetizione ( ), le connessioni possono essere eseguite molto

velocemente nel modo seguente, se i piedini del componente sono allineati in ordine incrementale (una
pratica comune in componenti come memorie, microprocessori, ecc.):

Piazzare la prima etichetta (per esempio PCA0 )

Usare il tasto di ripetizione quanto serve per piazzare membri. KiCad creerà automaticamente le
etichette successive ( PCA1 , PCA2…​) allineate verticalmente, teoricamente nella esatta posizione degli

altri piedini.

Disegnare il filo sotto la prima etichetta. Usare poi il comando di ripetizione per piazzare gli altri fili

sotto le etichette.

Se necessario, piazzare le voci di bus allo stesso modo (piazzare la prima voce, poi usare il tasto di
ripetizione).

Ins
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NOTE

Nella sezione Editor schemi elettrici → Opzioni di modifica del menu delle preferenze,
è possibile impostare i parametri di ripetizione:

Passo orizzontale

Passo verticale

Incremento etichetta (che perciò potrà essere incrementata o decrementata di 2, 3,
ecc.)

Dispiegamento bus
Lo strumento di dispiegamento permette di estrarre velocemente i segnali da un bus. Per dispiegare un
segnale, fare clic con il tasto destro del mouse su un oggetto di tipo bus (un filo di bus, ecc) e scegliere

Dispiega bus. In alternativa, usare il tasto comando Dispiega bus (predeinito: ) quando il puntatore è
posizionato sopra un oggetto di tipo bus. Il menu permette di selezionare quale membro del bus dispiegare.

Dopo aver selezionato il membro del bus, il successivo clic posizionerà l’etichetta del membro del bus alla
posizione desiderata. Lo strumento genera automaticamente una voce bus ed un filo in direzione della

posizione dell’etichetta. Dopo il posizionamento dell’etichetta, si può continuare a posizionare altri
segmenti di filo (per esempio, per connetterli ai pin di un componente) e completare il collegamento in uno
qualsiasi dei normali metodi.

Alias di bus
Gli alias di bus sono scorciatoie che permettono di lavorare con grandi insiemi di bus in modo più efficiente.
Essi permettono di definire un gruppo di bus e dare ad esso un nome corto che può essere usato poi al posto

del nome completo in tutto lo schema elettrico.

Per creare un alias di bus, aprire la finestra di dialogo Definizioni del bus nel menu Strumenti.

C
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Ad un alias si può dare come nome un qualsiasi nome di segnale valido. Usando la finestra di dialogo, si
possono aggiungere segnali o bus vettoriali all’alias. Come scorciatoia, si può battere o incollare dentro
un’elenco di segnali e/o buse separati da spazi, e questi verranno aggiunti alla definizione di alias. In questo
esempio, definiamo un alias chiamato USB  con membri DP , DM , e VBUS .

Dopo la definizione di un alias, esso può essere usato in una etichetta di bus di gruppo mettendo il nome
dell’alias dentro le parentesi graffe del bus di gruppo: {USB} . Ciò ha lo stesso effetto dell’etichettare il bus
{DP DM VBUS} . Si può anche aggiungere un nome prefisso al gruppo, come USB1{USB} , il che da come
risultati collegamenti come USB1.DP  come descritto sopra. Per bus complessi, l’uso di alias può rendere

l’etichettatura dello schema elettrico molto più corta. Si faccia attenzione al fatto che gli alias sono solo
scorciatoie, e che il nome dell’alias non viene incluso nella netlist.

Gli alias dei bus vengono salvati nel file dello schema elettrico. Qualunque alias creato in un dato foglio dello
schema elettrico è disponibile all’uso in qualunque altro foglio della gerarchia dello progetto.

Bus con più di una etichetta
KiCad 5.0 e versioni precedenti permettevano la connessione di bus con diverse etichette assieme, e

collegavano assieme i membri di detti bus durante la creazione della netlist. Questo comportamento è stato
eliminato in KiCad 6.0 perché è incompatibile con i bus di gruppo, e anche perché tendeva a creare
confusione nelle netlist perché il nome che un dato segnale avrebbe ricevuto non era facilmente predicibile.

Se si apre un progetto che faceva uso di questa caratteristica in una versione moderna di KiCad, si potrà

osservare la finestra di dialogo di ``Migrazione bus'' che vi guiderà attraverso la procedura di
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aggiornamento dello schema in modo tale da garantire l’esistenza di una sola etichetta per un dato insieme
di collegamenti bus.

Per ogni insieme di fili di bus che ha più di una etichetta, è necessario scegliere l’etichetta da tenere. Il menu
a discesa permette di scegliere tra le etichette che esistono nel progetto, oppure è anche possibile scegliere

un nome ancora diverso inserendolo manualmente nel campo del nuovo nome.

Hidden Power Pins
When the power pins of a symbol are visible, they must be connected, as with any other signal. However,
symbols such as gates and flip-flops are sometimes drawn with hidden power input pins which are
connected implicitly.

KiCad automatically connects invisible pins with type "power input" to a global net with the same name as
the pin. For example, if a symbol has a hidden power input pin named VCC , this pin will be globally
connected to the VCC  net on all sheets.

NOTE
Hidden pins can be shown in the schematic by checking the Show hidden
pins option in
the Schematic Editor → Display Options section
of the preferences, or by selecting View
→ Show hidden pins.
There is also a toggle icon  on the
left toolbar.

Potrebbe rendersi necessario collegare assieme collegamenti (net) di potenza con nomi diversi (per
esempio, GND  nei componenti TTL e VSS  in quelli in tecnologia MOS). Per fare ciò, si aggiunga un simbolo di
pin di potenza per ogni collegamento (net) e li si colleghi assieme tramite un filo.

Se vengono usati pin di potenza nascosti, non è raccomandabile usare etichette locali per le connessioni di
potenza, dato che queste ultime non connetterebbero i piedini di potenza nascosti su altri fogli.
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NOTE

Care must be taken with hidden power input pins because they can create
unintentional
connections. By nature, hidden pins are invisible and do not
display their pin name. This
makes it easy to accidentally connect two
power pins to the same net. For this reason,
using invisible power pins
 in symbols is not recommended outside of power port
symbols, and is only
supported for compatibility with legacy designs and symbols.

Porte di potenza
Power ports are symbols that are conventionally used to represent a connection to a power net, such as VCC

or GND . In addition to being a visual indicator that the attached net is a power rail, power ports make global
connections: two power ports with the same pin name connect to each other anywhere in the schematic,
regardless of sheet.

In the figure below, power port symbols are used to connect the positive and negative terminals of the

capacitors to the VCC  and GND  nets, respectively.

In the KiCad standard library, power ports are found in the power  library, but power port symbols can be
created in any library. To create a custom power port, make a new symbol with a power input pin that is set
to be invisible. Name the pin according to the desired power net. In addition, set the "Define as power
symbol" symbol property. As described in the hidden power pins section, invisible power input pins make

global connections based on the hidden power pin’s name. The process of creating a power port is described
in more detail in the Symbol Editor section.

NOTE
The connected net name is determined by the power port’s pin name, not
the name or
value of the symbol. This means that power port net names
can only be changed in the
symbol editor, not in the schematic.

Net name assignment rules
Every net in the schematic is assigned a name, whether that name is specified by the user or automatically
generated by KiCad.

When multiple labels are attached to the same net, the final net name is determined in the following order,
from highest priority to lowest:

1. Etichette globali
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Power ports

3. Etichette locali

4. Etichette gerarchiche

5. Pin fogli gerarchici

If there are multiple labels of one type attached to a net, the names are sorted alphabetically and the first is
used.

If a net travels through multiple sheets in a hierarchy, and has no global label or power port, it will take its

name from the highest level of the hierarchy where it has a hierarchical label or local label. As described
above, local labels take priority over hierarchical labels.

If none of the labels above are attached to a net, the net’s name is automatically generated based on the
connected symbol pins.

PWR_FLAG
Due simboli PWR_FLAG  sono visibili nella schermata soprastante. Essi indicano all’ERC che le due net di
potenza VCC  e GND  sono effettivamente connesse ad una sorgente di potenza, dato che non c’è una sorgente
di potenza esplicita come l’uscita di un regolatore di tensione collegata a nessuno dei due collegamenti.

Without these two flags, the ERC tool would diagnose: Error: Input Power pin not driven by any Output

Power pins.

The PWR_FLAG  symbol is found in the power  symbol library. The same effect can be achieved by connecting
any power output pin to the net.

Indicatore di Non-connesso
No-connection flags ( ) are used to indicate that a pin is intentionally unconnected. These flags do not

have any effect on the schematic’s connectivity, but they prevent "unconnected pin" ERC warnings for pins

that are intentionally unconnected.

Elementi grafici

Testi e linee grafiche
Può essere utile (alla comprensione dello schema elettrico) piazzare annotazioni in forma di campi o

riquadri di testo. I campi testo (strumento ) e le linee grafiche (strumento ) servono a questo scopo,

al contrario di etichette e fili che sono elementi di connessione.

The image below shows graphic lines and text in addition to wires, local labels, and hierarchical labels.
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Blocco del titolo del foglio
Il riquadro iscrizioni viene modificato con lo strumento per le inpostazioni pagina ( ).

Each field in the title block can be edited, as well as the paper size and orientation. If the "Export to other
sheets" option is checked for a field, that field will be updated in the title block of all sheets, rather than only
the current sheet.

È possibile impostare la data odierna premendo il pulsante con la freccia a sinistra di "Data versione", visto
che questa non viene cambiata automaticamente.

A drawing sheet template file can also be selected.
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The sheet number (Sheet X/Y) is automatically updated, but sheet page numbers can also be manually set
using Edit → Edit Sheet Page Number…​.

Impostazioni schema
La finestra Impostazioni schema viene utilizzata per impostare le opzioni dello schema che sono specifiche
dello schema attualmente attivo. Ad esempio, la finestra contiene le opzioni di formattazione, la
configurazione delle regole elettriche, l’impostazione della netclass e l’impostazione delle variabili di testo

dello schema.

Recupero di simboli dalla cache
Come impostazione predefinita, KiCad carica i simboli dalle librerie del progetto, secondo le impostazioni
dei percorsi e l’ordine delle librerie. Ciò può provocare dei problemi durante il caricamento di progetti
molto vecchi: se i simboli nella libreria sono cambiati o sono stati rimossi o la libreria non esiste più da

quando erano stati usati nel progetto, i simboli presenti nel progetto vengono automaticamente rimpiazzati
dalle corrispondenti nuove versioni. Le nuove versioni potrebbero allinearsi correttamente o potrebbero
essere orientati diversamente, generando così uno schema errato.

Quando un progetto viene salvato, viene salvata anche una libreria archivio (cache), contenente i simboli

usati nel progetto, con esso. Ciò consente di distribuire il progetto senza tutte le librerie. Se si carica un
progetto i cui simboli sono presenti sia nella libreria archivio (cache) che nelle le librerie di sistema, KiCad
scansionerà le librerie per rilevare eventuali conflitti. Se vengono rilevati conflitti questi verranno elencati
nella finestra di dialogo seguente:
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Si può vedere in questo esempio che il progetto in origine aveva usato un diodo con il catodo verso l’alto,

ma ora la libreria ne contiene uno con il catodo verso il basso. Questo cambiamento può rovinare il
progetto! Premendo OK qui farà in modo di salvare il vecchio simbolo in una speciale libreria di recupero , e
tutti i componenti che usano quel simbolo verranno rinominati per evitare conflitti di nome.

Se si preme Annulla, nessun recupero verrà effettuato, perciò KiCad caricherà i nuovi componenti come

impostazione predefinita. Se si salva lo schema a questo punto, la cache verrà sovrascritta e i vecchi simboli
non saranno più recuperabili. Se si è salvato lo schema, è ancora possibile tornare indietro ed eseguire
ancora la funzione di recupero: scegliere "Recupera vecchi componenti" nel menu strumenti per richiamare
nuovamente la finestra di dialogo.

Se si preferisce non visualizzare questa finestra di dialogo, è possibile premere ``Non mostrare più''.
L’impostazione predefinita non farà nulla e permetterà di caricare i nuovi componenti. Questa opzione può
essere ripristinata nelle preferenze delle librerie.
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Schemi elettrici gerarchici
Introduzione
In KiCad, multi-sheet schematics are hierarchical: there is a single root sheet, and additional sheets are
created as subsheets of either the root sheet or another subsheet. Sheets can be included in a hierarchy
multiple times, if desired.

Carefully drawing a schematic as a hierarchical design improves schematic legibility and reduces repetitive

drawing.

Creating a hierarchical schematic starts from the root sheet. The process is to create a subsheet, then draw
the circuit in the subsheet and make the necessary electrical connections between sheets. Connections can be
made between nets in a subsheet and nets in the parent sheet using hierarchical pins and labels, or between

any two nets in the hierarchy using global labels.

Adding sheets to a design
You can add a subsheet to a design with the Add Hierarchical Sheet tool (  hotkey, or the  button in the

right toolbar). Launch the tool, then click twice in the canvas to draw the upper left and lower right corners
of the subsheet symbol. Make the sheet outline large enough to fit the hierarchical pins you will add later.

The Sheet Properties dialog will appear and prompt you for a sheet name and filename.

S
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The sheet name must be unique, as it is used in the full net name for any nets in the subsheet. For example, a
net with the local label net1  in the sheet sheet1  would have a full net name of /sheet1/net1 . The sheet

name is also used to refer to the sheet in various places in the GUI, including the title block and the hierarchy
navigator.

The sheet filename specifies the file that the new sheet will be saved to or loaded from. The path to the

sheet file can be relative or absolute. It is usually preferable to save subsheet files in the project directory
and use a relative path so that the project is portable.

A single sheet file can be used more than once in a project by specifying the same filename for each repeated
sheet; the circuit drawn in the sheet will be instantiated once per usage, and any edits in once instance will

be reflected in the other instances.

NOTE
Sheet files can be shared between multiple projects to allow design reuse between
projects. However, this is not recommended due to path portability concerns and the risk
of unintentionally changing other projects while editing a shared sheet.

The sheet’s page number is configurable here. The page number is displayed in the sheet title block and the

hierarchy navigator, and sheets are sorted by page number in the hierarchy navigator and when printing or
plotting.

Several graphical options are also available. Border width sets the width of the border around the sheet
shape. Border color and Background fill set the color for the border and fill of the sheet shape,

respectively. If no color is set, a checkerboard swatch is shown and the default values from the color theme
are used.

The Sheet Properties dialog can be accessed at any time by selecting a sheet symbol and using the  hotkey,
or by right-clicking on a sheet symbol and selecting Properties…​.

E
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Navigating between sheets
You can enter a hierarchical sheet from the parent sheet by double-clicking the child sheet’s shape, or right-
clicking the child sheet and selecting Enter Sheet.

Return to the parent sheet by using the  button in the top toolbar, or by right-clicking in an empty part of

the schematic and clicking Leave Sheet.

Alternatively, you can jump to any sheet with the hierarchy navigator. To open the hierarchy navigator, click

the  button in the top toolbar. Each sheet in the design is displayed as an item in the tree. Clicking a sheet

name opens that sheet in the editing canvas.

By default, the hierarchy navigator closes after a new sheet is opened. It can be configured to always remain
open by selecting the Keep hierarchy navigator open option in the Editing Options section of the
Schematic Editor preferences.

Connessioni elettriche tra fogli

Panoramica etichette
Electrical connections between sheets are made with labels. There are several kinds of labels in KiCad, each

with a different connection scope.

Local labels only make connections within a sheet. Therefore local
 labels cannot be used to connect

between sheets. Local labels are added with
the  button.

Global labels make connections anywhere in a schematic, regardless of sheet.
Global labels are added

with the
  button.

Le etichette gerarchiche si connettono ai pin del foglio gerarchico accessibili
nel foglio principale. I

progetti gerarchici si basano su etichette e pin gerarchici
per creare connessioni tra fogli padre e fogli
figli; si può pensare ai pin gerarchici
 come mezzi per definire l’interfaccia per un foglio. Le etichette

gerarchiche vengono
aggiunte con il pulsante
 .

NOTE Labels that have the same name will connect, regardless of the label type,
if they are in the
same sheet.



35

NOTE Hidden power pins can also be considered global
labels, because they connect anywhere
in the schematic hierarchy.

Pin fogli gerarchici
After placing hierarchical labels within the subsheet, matching hierarchical pins can be added to the

subsheet symbol in the parent sheet. You can then make connections to the hierarchical pins with wires,
labels, and buses. Hierarchical pins in a subsheet symbol are connected to the matching hierarchical labels in
the subsheet itself.

NOTE Hierarchical labels must be defined in the subsheet before the
corresponding hierarchical
sheet pin can be imported in the sheet symbol.

Per ogni etichetta gerarchica nel sottofoglio, importare il pin gerarchico corrispondente nel simbolo del

foglio facendo clic sul pulsante  nella barra degli strumenti a destra, quindi facendo clic sul simbolo del

foglio. Un segnaposto per la prima etichetta gerarchica senza corrispondenza verrà attaccato al puntatore,
dove può essere posizionato ovunque lungo il bordo del simbolo del foglio. Facendo nuovamente clic con lo
strumento si continuerà ad importare ulteriori pin del foglio fino a quando non ci saranno più pin gerarchici

da importare dal sottofoglio. I pin foglio possono essere importati anche selezionando Importa pin fogli
nel menu contestuale del simbolo del foglio.

You can edit the properties of a sheet pin in the Sheet Pin Properties dialog. Open this dialog by double-
clicking a sheet pin, selecting a sheet pin and using the  hotkey, or right-clicking a sheet pin and selecting

Properties…​.

E
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The sheet pin’s name can be edited in the textbox or by selecting from the dropdown list of hierarchical
labels in the subsheet. A sheet pin’s name has to match the corresponding hierarchical label in the subsheet,
so if a pin name is changed the label must change as well.

The connection type changes the shape of the sheet pin, and has no electrical effect. It can be set to Input,

Output, Bidirectional, Tri-state, or Passive. The pin’s text size can also be changed.

Esempi di progettazioni gerarchiche
I disegni gerarchici possono essere classificati in diverse categorie:

Semplice: ogni foglio viene usato solo una volta.

Complessa: alcuni fogli sono istanziati più volte.

Piatta: sottocaso di gerarchia Semplice, senza connessioni tra i
sottofogli e il loro genitore. Le gerarchie

piatte possono essere usate
per rappresentare una progettazione non gerarchica.

Ogni modello gerarchico può essere utile; quello più appropriato dipende dal progetto.

Gerarchia semplice
An example of a simple hierarchy is the video  demo project included with KiCad. The root sheet contains
seven unique subsheets, each with hierarchical labels and sheet pins linking the sheets to each other in the
root sheet. Two of the subsheet symbols are shown below.
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Gerarchia complessa
The complex_hierarchy  demo project is an example of a complex hierarchy. The root sheet contains two

subsheet symbols, which both refer to the same sheet file ( ampli_ht.kicad_sch ). This allows the design to
include two copies of the same amplifier circuit. Although the two sheet symbols refer to the same filename,
the sheet names are unique ( ampli_ht_vertical  and ampli_ht_horizontal ). Inside each subsheet the
circuits are identical except for the reference designators, which as always are unique.

This project contains no sheet pin connections. The only connections between the root sheet and the
subsheets are global power connections made with power port symbols. However, sheets in a complex
hierarchy could include sheet pin connections if appropriate for the design.
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Gerarchia piatta
The flat_hierarchy  demo project is an example of a flat hierarchy. The root sheet contains two unique

subsheet symbols with no hierarchical sheet pins. The root sheet in this project does nothing except hold the
subsheets, and the subsheets are used only as additional pages in the schematic.

NOTE This is the simplest way to create multi-page schematics in KiCad.
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Ispezione di uno schema
Strumento trova
The Find tool searches for text in the schematic, including reference designators, pin names, symbol fields,
and graphic text. When the tool finds a match, the canvas is zoomed and centered on the match and the text

is highlighted. Launch the tool using the  button in the top toolbar.

Lo strumento trova ha diverse opzioni:

Match case: Selects whether the search is case-sensitive.

Words: When selected, the search will only match the search term with complete
words in the schematic.
When unselected, the search will match if the search
term is part of a larger word in the schematic.

Wildcards: When selected, wildcards can be used in the search terms. ? 
matches any single character, and
*  matches any number of characters. Note
 that when this option is selected, partial matches are not
returned: searching
for abc*  will match the string abcd , but searching for abc  will not.

Search pin names and numbers: Selects whether the search should apply to pin
names and numbers.

Search hidden fields: Selects whether the search should apply only to visible
fields or if it should include
hidden symbol fields.

Search the current sheet only: Selects whether the search should be limited to
the current schematic sheet

or to the entire schematic.

There is also a Find and Replace tool which is activated with the  button in the top toolbar. This tool

behaves the same as the Find tool, but additionally can replace some or all matches with different text.
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If the Replace matches in reference designators option is checked, reference designators will be modified
if they contain matching text. Otherwise reference designators will not be affected.

Evidenziazione net
An electrical net can be highlighted in the schematic editor to visualize all of the places it appears in the
schematic. Net highlighting can be activated in the Schematic Editor or by highlighting the corresponding net

in the PCB editor when cross-probe highlighting is enabled (see below). When net highlighting is active, the
highlighted net will be shown in a different color. By default this color is pink, but it is configurable in the
Color section of the Preferences dialog.

Nets can be highlighted by clicking on a wire or pin using the Highlight Net tool in the right toolbar ( ).

Alternatively, the Highlight Net hotkey ( ) highlights the net under the cursor. If there are no nets or pins

under the cursor, any existing highlighting will be cleared. The highlighting can also be cleared by using the
Clear Net Highlight action (hotkey ).

Cross-probing from the PCB
KiCad allows bi-directional cross-probing between the schematic and the PCB. There are several different
types of cross-probing.

Selection cross-probing allows you to select a symbol or pin in the schematic
to select the corresponding
footprint or pad in the PCB (if one exists) and
vice-versa. By default, cross-probing will result in the display
centering on
the cross-probed item and zooming to fit. This behavior can be disabled in the
Display Options
section of the Preferences dialog.

Highlight cross-probing allows you to highlight a net in the schematic and PCB
at the same time. If the
option "Highlight cross-probed nets" is enabled in the
 Display Options section of the Preferences dialog,
highlighting a net or bus in
the schematic editor will cause the corresponding net or nets to be highlighted
in

the PCB editor, and vice versa.

Verifica della progettazione con il Controllo Regole Elettriche
(ERC)
Lo strumento per il controllo regole elettriche (ERC) esegue un controllo automatico dello schema elettrico.

L’ERC segnala gli errori presenti nel foglio, come piedini sconnessi, simboli gerarchici sconnessi, uscite in
corto-circuito, ecc. L’ERC segnala errori o avvisi a seconda della gravità del problema rilevato.

`

~
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Naturally, an automatic check is not infallible, and it is not possible to detect all design errors. Such a check is
still very useful, because it allows you to detect many oversights and small errors. All detected issues should

be checked and addressed before proceeding.

La qualità dell’ERC è direttamente correlata alla cura posta nel dichiarare le proprietà elettriche durante la
creazione della libreria di simboli.

l’ERC può essere avviato facendo clic sul pulsante  nella barra strumenti in cima e facendo clic sul

pulsante Esegui ERC.

Any warnings or errors are reported in the Violations tab, and markers for each violation are placed in the
schematic so that they point to the relevant part of the schematic. Warnings are indicated by yellow arrows,

and errors have red arrows. Excluded violations are shown as green arrows.

NOTE Selezionando una violazione nella finestra ERC si passa al marcatore di violazione
selezionato nello schema.
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The numbers at the bottom of the window show the number of errors, warnings, and exclusions. Each type
of violation can be filtered from the list using the respective checkboxes. Clicking Delete Markers will clear

all violations until ERC is run again.

Violations can be right-clicked in the dialog to ignore them or change their severity:

Exclude this violation: ignores this particular violation, but does not
affect any other violations.

Change severity: changes a type of violation from warning to error, or error
to warning. This affects all
violations of a given type.

Ignore all: ignores all violations of a given type.

Esempio di ERC

Qui si possono osservare tre errori:

Due uscite sono state collegate assieme (freccia rossa sulla destra).

Due ingressi sono stati lasciati sconnessi (freccia verde sulla sinistra).
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Selecting an ERC marker displays a description of the violation in the message pane at the bottom of the
window.

Piedini e segnalazioni di potenza
It is common to have an "Input Power pin not driven by any Output Power pins" error on power pins, as
shown in the example below, even though the power pins seem to be properly connected to a power rail.
This happens in designs where the power is provided through connectors or other components that are not
marked as power outputs. In these cases ERC won’t detect any Output Power pins connected to the net and

will determine the Input Power pin is not driven by a power source.
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To avoid this warning, connect the net to PWR_FLAG  symbol on such a power net as shown in the following
example. The PWR_FLAG  symbol is found in the power  symbol library. Alternatively, connect any power
output pin to the net; PWR_FLAG  is simply a symbol with a single power output pin.
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Le reti di massa spesso necessitano anche di un PWR_FLAG , poiché i regolatori di tensione hanno uscite
dichiarate come uscite di potenza, ma i loro pin di massa sono tipicamente contrassegnati come ingressi di

alimentazione. Pertanto le masse possono apparire non collegate a una fonte a meno che non venga
utilizzato un simbolo PWR_FLAG .

For more information about power pins and power flags, see the PWR_FLAG  documentation.

Configurazione ERC
Il pannello Mappa conflitti pin nelle Impostazioni dello schema, permette di configurare le regole di

connessione per definire le condizioni elettriche per il controllo di errori e avvertimenti in base al tipo di
pin connesso uno con l’altro.

Le regole possono essere cambiate facendo clic sul riquadro desiderato della matrice, in modo da
selezionare la scelta desiderata: normale, avvertimento, errore.
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Il pannello Importanza violazione nella Impostazione dello schema permette di configurare che tipo di

messaggi ERC devono essere riportati come errori, come semplici avvertimenti o ignorati.

File rapporto ERC
Un file di rapporto ERC può essere generato e salvato facendo clic sul pulsante Salva…​ nella finestra di
dialogo ERC. L’estensione file per i file rapporto ERC è .rpt . Ecco un file rapporto ERC di esempio.

ERC report (Fri 21 Oct 2022 02:07:05 PM EDT, Encoding UTF8)



***** Sheet /

[pin_not_driven]: Input pin not driven by any Output pins

    ; Severity: error

    @(149.86 mm, 60.96 mm): Symbol U1B [74LS00] Pin 4 [, Input, Line]

[pin_not_connected]: Pin not connected

    ; Severity: error

    @(149.86 mm, 60.96 mm): Symbol U1B [74LS00] Pin 4 [, Input, Line]

[pin_not_connected]: Pin not connected

    ; Severity: error

    @(149.86 mm, 66.04 mm): Symbol U1B [74LS00] Pin 5 [, Input, Line]

[pin_to_pin]: Pins of type Output and Output are connected

    ; Severity: error

    @(165.10 mm, 63.50 mm): Symbol U1B [74LS00] Pin 6 [, Output, Inverted]

    @(165.10 mm, 46.99 mm): Symbol U1A [74LS00] Pin 3 [, Output, Inverted]

[pin_not_driven]: Input pin not driven by any Output pins

    ; Severity: error

    @(149.86 mm, 66.04 mm): Symbol U1B [74LS00] Pin 5 [, Input, Line]



 ** ERC messages: 5  Errors 5  Warnings 0
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Assegnazione impronte
Prima di sbrogliare un C.S., è necessario selezionare le impronte per ogni componente che verrà assemblato
sulla scheda. Le impronte definiscono le connessioni in rame tra i componenti fisici e le tracce sbrogliate su
un circuito stampato.

Alcuni simboli vengono forniti con impronte preassegnate, ma per molti simboli ci sono più impronte

possibili, quindi l’utente deve selezionare quella appropriata.

KiCad offre diversi metodi per assegnare impronte:

Proprietà del simbolo

Finestra proprietà del simbolo

Tabella campi del simbolo

Mentre si piazzano i simboli

Strumento di assegnamento impronte

Ogni metodo verrà spiegato di seguito. Quale usare è una questione di preferenze; un metodo può essere

più conveniente a seconda della situazione. Tutti questi metodi sono equivalenti in quanto memorizzano il
nome dell’impronta selezionata nel campo Impronta  del simbolo.

NOTE
La tabella librerie impronte deve essere configurata prima che le impronte possano
essere assegnate. Per informazioni sulla configurazione della tabella libreria impronte,
consultare il manuale dell’editor di circuiti stampati.

Assegnare impronte nelle proprietà del simbolo
Il campo Impronta  di un simbolo può essere modificato direttamente nella finestra Proprietà del simbolo.

file:///src/build/src/eeschema/pcbnew/pcbnew_footprints_and_libraries.html#managing-footprint-libraries
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Facendo clic sul pulsante  nel campo Impronta  si apre l’Esploratore librerie di impronte, che mostra le
impronte disponibili e le librerie di impronte. Un singolo clic sul nome di un’impronta seleziona l’impronta e

la visualizza nel riquadro di anteprima a destra, mentre il doppio clic su un’impronta chiude l’esploratore e
imposta il campo Impronta  del simbolo all’impronta selezionata.

Assegnamento impronte con la tabella campi del simbolo
Anziché modificare singolarmente le proprietà di ciascun simbolo, è possibile utilizzare la Tabella campi
simbolo per visualizzare e modificare le proprietà di tutti i simboli nel disegno da un unico posto. Ciò
include l’assegnazione di impronte modificando il campo Impronta  di ciascun simbolo.

La tabella campi simbolo è accessibile tramite Strumenti → Modifica i campi del simbolo…​, o con il
pulsante  nella barra in alto.

Il campo Impronta  qui si comporta come nella finestra delle proprietà del simbolo: può essere modificato
direttamente o le impronte possono essere selezionate visivamente con l’Esploratore librerie di impronte.



49

Per ulteriori informazioni sulla tabella dei campi dei simboli, vedere la sezione modifica proprietà simboli.

Assegnazione impronte piazzando simboli
Le impronte possono essere assegnate ai simboli quando il simbolo viene aggiunto per la prima volta allo
schema.

Alcuni simboli sono definiti con una impronta predefinita. Questi simboli avranno questa impronta
preassegnata quando verranno aggiunti allo schema. L’impronta predefinita è visibile nella finestra di

dialogo Aggiungi simbolo. Per i simboli senza una impronta predefinita definita, il menu a discesa
dell’impronta indicherà "Nessuna impronta predefinita" e l’area di anteprima dell’impronta indicherà
"Nessuna impronta specificata".
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I simboli possono avere filtri impronte che specificano quali impronte sono appropriate per un dato
simbolo. Se il filtro impronte è definito per il simbolo selezionato, tutte le impronte che avranno un

riscontro con il filtro appariranno come opzioni nell’elenco a discesa impronte. L’impronta selezionata verrà
visualizzata nell’area di anteprima e verrà assegnata al simbolo quando il simbolo verrà aggiunto allo
schema.

NOTE

Le opzioni impronte non appariranno nell’elenco a discesa delle impronte se non
vengono caricate le librerie di impronte. Le librerie di impronte vengono caricate la prima
volta che l’Editor impronte o l’Esploratore librerie di impronte vengono aperti in una
sessione.

Per ulteriori informazioni sui filtri impronte, vedere Documentazione dell’editor dei simboli.

Assegnamento impronte tramite lo strumento di assegnamento
impronte
Lo strumento di assegnazione impronte consente di associare i simboli nello schema alle impronte usate
durante la disposizione del circuito stampato. Fornisce un elenco filtrabile di impronte, la visualizzazione
delle impronte e la visualizzazione 3D del modello del componente, per aiutare nella verifica della corretta

associazione dell’impronta al componente.

I componenti possono essere assegnati alle loro impronte corrispondenti manualmente o automaticamente
creando i file di equivalenze (file .equ). I file delle equivalenze sono tabelle di corrispondenza che associano
ogni componente alla sua impronta.
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Eseguire lo strumento con Strumenti → Assegna impronte…​ o facendo clic sull’icona  nella barra degli

strumenti in alto.

Panoramica dello strumento di assegnamento impronte
L’immagine sottostante mostra la finestra principale dello strumento assegnamento impronte.

Il riquadro a sinistra contiene l’elenco delle librerie di impronte disponibili associate al progetto.

Il pannello centrale contiene l’elenco dei simboli nello schema.

Il pannello di destra contiene l’elenco delle impronte disponibili caricate dalle librerie di impronte del

progetto.

Il pannello in basso descrive i filtri che sono stati applicati all’elenco impronte e visualizza le

informazioni sull’impronta selezionata nel pannello più a destra.

La barra superiore contiene i seguenti comandi:
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Transferisci le associazioni impronte correnti allo schema elettrico.

Modifica le tabelle librerie impronte globali e del progetto.

Visualizza l’impronta selezionata nel visualizzatore impronte.

Seleziona il simbolo precedente senza associazione impronta.

Seleziona il simbolo successivo senza associazione impronta.

Annulla l’ultima modifica.

Ripete l’ultima modifica.

Esegue l’associazione automatica impronte usando un file di equivalenze.

Elimina tutte le assegnazioni impronte.

Filtra l’elenco impronte usando i filtri impronte definiti nel simbolo
selezionato.

Filtra l’elenco impronte usando il numero di pin del simbolo selezionato.

Filtra l’elenco impronte usando la libreria selezionata.

La seguente tabella elenca i comandi da tastiera per l’assegnamento impronte.

Freccia
destra /
Tab

Attiva il pannello adiacente a destra del pannello attualmente attivo.
A
capo al primo pannello se è attivo l’ultimo pannello.

Freccia
sinistra

Attiva l’adiacente pannello a sinistra del pannello
attualmente attivo.
A capo all’ultimo pannello se è attivo il primo pannello.

Freccia su Seleziona l’elemento precedente all’elemento attualmente selezionato.

Freccia
giù

Seleziona l’elemento successivo all’elemento attualmente selezionato.

Pagina su Seleziona l’elemento di una pagina precedente all’elemento
attualmente selezionato.

Pagina giù Seleziona l’elemento di una pagina successiva all’elemento
attualmente selezionato.

Home Seleziona il primo elemento dell’elenco attualmente selezionato.

Fine Seleziona l’ultimo elemento dell’elenco attualmente selezionato.
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Associazione manuale delle impronte con lo strumento assegnamento
impronte
Per associare manualmente una impronta ad un componente, bisogna prima selezionare un componente nel

pannello componenti (centro). Poi selezionare un’impronta nel pannello delle impronte (destra) facendo
doppio clic con il pulsante sinistro del mouse sul nome dell’impronta desiderata. L’impronta verrà assegnata
al componente selezionato, ed il prossimo componente senza un’impronta assegnata verrà
automaticamente selezionato.

NOTE Se non vengono visualizzate impronte nel pannello impronte, verificare che le opzioni
filtro impronte siano state applicate correttamente.

Quando a tutti i componenti sono state assegnate impronte, fare clic sul pulsante OK per salvare le
assegnazioni e uscire dallo strumento. In alternativa, fare clic su Annulla per eliminare le assegnazioni

aggiornate o su Applica, salva schema e continua per salvare le nuove assegnazioni senza uscire dallo
strumento.

Filtro dell’elenco impronte
Sono disponibili quattro opzioni di filtro che limitano le impronte visualizzate nel pannello impronte. Le
opzioni di filtro sono abilitate e disabilitate con tre pulsanti e una casella di testo nella barra degli strumenti
in alto.

: Attiva filtri che possono essere definiti in ogni simbolo. Ad esempio, un simbolo opamp potrebbe

definire filtri che mostrano solo impronte SOIC e DIP.

: mostra solo impronte che corrispondono al numero di pin del simbolo selezionato.

: mostra solo le impronte della libreria selezionata nel riquadro di sinistra.

L’inserimento di testo nella casella nasconde le impronte che non corrispondono al testo. Questo filtro è

disabilitato quando la casella è vuota.

Quando tutti i filtri sono disattivati, viene visualizzato l’elenco completo delle impronte.

I filtri applicati sono descritti nel riquadro inferiore della finestra, insieme al numero di impronte che
soddisfano i filtri selezionati. Ad esempio, quando i filtri impronte e i filtri conteggio pin simbolo sono
abilitati, il riquadro inferiore stampa i filtri impronta e conteggio pin:

È possibile utilizzare più filtri contemporaneamente per restringere l’elenco impronte eventualmente
appropriate nel riquadro delle impronte. I simboli nella libreria standard di KiCad definiscono i filtri

impronte progettati per essere utilizzati in combinazione con i filtri conteggio pin.
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Associazione automatica di impronte con lo strumento di assegnamento
impronte
Lo strumento di assegnazione impronte consente di memorizzare le assegnazioni delle impronte in un file

esterno e di caricare le assegnazioni in un secondo momento, anche in un progetto diverso. Ciò consente di
associare automaticamente i simboli alle impronte appropriate.

Il file esterno viene definito come un file di equivalenza e memorizza una mappatura di un simbolo ad
un’impronta corrispondente. I file di equivalenza in genere utilizzano l’estensione di file .equ . I file di

equivalenza sono file di testo semplice con una sintassi semplice e devono essere creati dall’utente
utilizzando un editor di testo. La sintassi è descritta di seguito.

È possibile selezionare i file di equivalenza da utilizzare facendo clic su Preferenze → Gestisci file
associazione impronte nello strumento di assegnazione impronte.

Aggiungere nuovi file di equivalenza facendo clic sul pulsante Aggiungi.
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Rimuovere il file di equivalenza selezionato facendo clic sul pulsante Rimuovi.

Modificare la priorità dei file di equivalenze facendo clic sui pulsanti Sposta su e Sposta giù. Se il valore
di un simbolo viene trovato in più file di equivalenze, l’impronta dell’ultimo file di equivalenze
corrispondente sostituirà i file di equivalenze precedenti.

Aprire il file di equivalenze selezionato facendo clic sul pulsante Modifica file.

Le variabili ambiente rilevanti sono mostrate nella parte inferiore della finestra. Quando l’opzione percorso
Relativo è selezionata, queste variabili ambiente verranno automaticamente utilizzate per creare percorsi
ai file di equivalenze selezionati relativi al progetto o alle librerie di impronte.

Una volta che i file di equivalenze desiderati sono stati caricati nell’ordine corretto, l’associazione
automatica delle impronte può essere eseguita facendo clic sul pulsante  nella barra degli strumenti

superiore dello strumento di assegnazione delle impronte.

Tutti i simboli con un valore trovato in un file di equivalenze caricato avranno le loro impronte assegnate
automaticamente. Tuttavia, i simboli che hanno già impronte assegnate non verranno aggiornati.

Formato file delle equivalenze
I file di equivalenze consistono di una riga per ogni valore del simbolo. Ogni riga ha la seguente struttura:

'<valore simbolo>' '<libreria impronte>:<nome impronta>'

Ogni nome/valore deve essere racchiuso tra virgolette singole ( ' ) e separato da uno o più spazi. Le righe
che iniziano con "#" sono commenti.

Ad esempio, se si desidera assegnare a tutti i simboli con il valore "LM4562" l’impronta "Package_SO:SOIC-
8_3.9x4.9_P1.27mm", la riga nel file di equivalenze deve essere:

'LM4562' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

Ecco un esempio di file di equivalenze:
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Visualizzazione dell’impronta corrente
Lo strumento di assegnazione delle impronte contiene un visualizzatore di impronte. Facendo clic sul

pulsante  nella barra degli strumenti in alto si avvia il visualizzatore di impronte e si mostra l’impronta

selezionata.

La barra superiore contiene i seguenti comandi:

#circuiti integrati (smd):

'74LV14' 'Package_SO:SOIC-14_3.9x8.7mm_P1.27mm'

'EL7242C' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'DS1302N' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LM324N' 'Package_SO:SOIC-14_3.9x8.7mm_P1.27mm'

'LM358' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LTC1878' 'Package_SO:MSOP-8_3x3mm_P0.65mm'

'24LC512I/SM' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LM2903M' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LT1129_SO8' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LT1129CS8-3.3' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LT1129CS8' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'LM358M' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'TL7702BID' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'TL7702BCD' 'Package_SO:SOIC-8_3.9x4.9_P1.27mm'

'U2270B' 'Package_SO:SOIC-16_3.9x9.9_P1.27mm'



#regulators

'LP2985LV' 'Package_TO_SOT_SMD:SOT-23-5_HandSoldering'
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Aggiorna vista

Zoom avanti

Zoom indietro

Mostra l’area giusta in finestra

Apri il visualizzatore modelli 3D

La barra strumenti di sinistra contiene i seguenti comandi:

Usa lo strumento di selezione

Misura interattivamente tra due punti

Mostra i punti o trattini della griglia

Mostra le coordinate nel sistema polare o rettangolare

Mostra le coordinate in pollici

Mostra le coordinate in mils (1/1000 di pollice)

Mostra le coordinate in millimetri

Cambia stile puntatore tra pieno schermo e normale

Cambia stile disegno numero piazzole tra normale e contorno

Cambia stile disegno delle piazzole tra normale e contorno

Cambia stile disegno del testo tra normale e contorno

Cambia stile disegno delle linee grafiche tra normale e contorno

Visualizzazione del modello 3D corrente
Facendo clic sul pulsante  si apre l’impronta nel visualizzatore del modello 3D.

NOTE Se non esiste un modello 3D per l’impronta corrente, nel Visualizzatore 3D verrà mostrata
solo l’impronta stessa.
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Il visualizzatore 3D è descritto nel manuale dell’editor di circuiti stampati.

file:///src/build/src/eeschema/pcbnew/pcbnew_inspecting.html#threed-viewer
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Transferring designs between schematic and
PCB
Update PCB from Schematic
Use the Update PCB from Schematic tool to sync design information from the Schematic Editor to the Board
Editor. The tool can be accessed with Tools → Update PCB from Schematic ( ) in both the schematic and

board editors. You can also use the  icon in the top toolbar of the Board Editor.

NOTE

Update PCB from Schematic is the preferred way to transfer design information from the
schematic to the PCB. In older versions of KiCad, the equivalent process was to export a
netlist from the Schematic Editor and import it into the Board Editor. It is no longer
necessary to use a netlist file.

The tool adds the footprint for each symbol to the board and transfers updated schematic information to
the board. In particular, the board’s net connections are updated to match the schematic.

The changes that will be made to the PCB are listed in the Changes To Be Applied pane. The PCB is not
modified until you click the Update PCB button.

You can show or hide different types of messages using the checkboxes at the bottom of the window. A

report of the changes can be saved to a file using the Save…​ button.

F8
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Opzioni
The tool has several options to control its behavior.

Option Description

Re-link footprints to schematic
symbols based on their reference
designators

Footprints are normally linked to schematic symbols via a unique
identifier
created when the symbol is added to the schematic. A
symbol’s unique identifier
cannot be changed.

If checked, each footprint in the PCB will be re-linked to the symbol
that has
the same reference designator as the footprint.

If unchecked, footprints and symbols will be linked by unique
identifier as
usual, rather than by reference designator. Each
footprint’s reference
designator will be updated to match the
reference designator of its linked
symbol.

This option should generally be left unchecked. It is useful for
specific
workflows that rely on changing the links between schematic
symbols and
footprints, such as refactoring a schematic for easier

layout or replicating
layout between identical channels of a design.

Delete footprints with no
symbols

If checked, any footprint in the PCB without a corresponding symbol
in the
schematic will be deleted from the PCB. Footprints with the
"Not in schematic"
attribute will be unaffected.

If unchecked, footprints without a corresponding symbol will not be
deleted.

Replace footprints with those
specified in the schematic

If checked, footprints in the PCB will be replaced with the footprint
that is
specified in the corresponding schematic symbol.

If unchecked, footprints that are already in the PCB will not be
changed, even
if the schematic symbol is updated to specify a
different footprint.

Update Schematic from PCB

NOTE DAFARE: scrivere questa sezione

Backannotation with CMP files
Select changes can also be synced from the PCB back to the schematic by exporting a CMP file from the PCB
editor (File → Export → Footprint Association (.cmp) File…​) and importing it in the Schematic Editor (File
→ Import → Footprint Assignments…​).

NOTE This method can only sync changes made to footprint assignments and footprint fields. It
is recommended to use the Update Schematic from PCB tool instead.



61

Generazione risultati
Stampa
KiCad can print the schematic to a standard printer using File→Print…​.

Opzioni di stampa
Stampa squadratura e riquadro iscrizioni del foglio: include la stampa del bordo del foglio e
del riquadro

iscrizioni nella stampa dello schema.

Stampa solo in bianco e nero: stampa lo schema in bianco e nero anziché a colori.

Print background color: Include the background color in the printed
schematic. This option is only enabled
if Print in black and white only is
disabled.

Use a different color theme for printing: Select a different color scheme
for printing than the one selected
for display in the Schematic Editor.

Page Setup…​: Opens a page setup dialog for setting paper size and
orientation.

Preview: Opens a print preview dialog.

Close: Closes the dialog without printing.

Print: Opens the system print dialog.

NOTE Printing uses platform- and printer-specific drivers and may have unexpected results.
When printing to a file, Plotting is recommended instead of Printing.

Tracciatura
KiCad can plot schematics to a file using File → Plot…​.
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I formati in uscita supportati sono Postscript, PDF, SVG, DXF e HPGL.

The Output Messages pane displays messages about the generated files. Different kinds of messages can be
shown or hidden using the checkboxes, and the messages can be saved to a file using the Save…​ button.

The Plot Current Page button plots the current page of the schematic. The Plot All Pages button plots all
pages of the schematic. One file is generated for each page, except for PDF output, which plots each

schematic page as a separate page in a single PDF file.

Opzioni di tracciatura
Output directory: Specify the location to save plotted files. If this is a
relative path, it is created relative to
the project directory.

Output Format: Select the format to plot in. Some formats have different
options than others.

Page size: Sets the page size to use for the plotted output. This can be set
to match the schematic size or to
another sheet size.

Plot drawing sheet: Include the drawing sheet border and title block in the
printed schematic.

Output mode: Sets the output to color or black and white. Not all output
formats support color.

Plot background color: Includes the schematic background color in the
plotted output. The background
color will not be plotted if the output format
does not support color or the output mode is black and white.

Color theme: Selects the color theme to use for the plotted output.
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Default line width: Selects the default width for lines without a specified
 thickness (lines that have
thickness set to 0). Lines that have a set thickness
will be plotted at that thickness instead.

Position and units: Sets the plotter origin and units. This option only
applies for HPGL output.

Pen width: Sets the plotter’s pen width. This option only applies for HPGL output.

Generazione della distinta materiali
KiCad can generate a Bill of Materials using Tools → Generate BOM…​ or the  button on the top toolbar.

The generated BOM lists all of the components in the design.

The BOM tool uses an external script to process the design information into the desired output format.
Several BOM generator scripts are included with KiCad, and users can also create their own. BOM generator
scripts generally use Python or XSLT, but other tools can be used as long as you can specify a command line

for KiCad to execute when running the generator.

You can select which BOM generator to use in the BOM generator scripts list. The rest of the dialog displays
information about the selected generator. You can change the displayed name of the generator with the
Generator nickname textbox.

The pane at right displays information about the selected script. When the generator is executed, the right
pane instead displays output from the script.
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The text box at the bottom contains the command that KiCad will use to execute the generator. It is
automatically populated when a script is selected, but the command may need to be hand-edited for some

generators. KiCad saves the command line for each generator when the BOM tool is closed, so command line
customizations are preserved. For more details about the command line, see the advanced documentation.

Su MS Windows, la finestra di dialogo del generatore DIBA ha un’opzione aggiuntiva Mostra finestra
console che controlla la visibilità della finestra del plugin esterno. Quando questa opzione è deselezionata, i

generatori di DIBA vengono eseguiti in una finestra di console nascosta e il risultato viene redirezionato e
visualizzato nella finestra di dialogo. Quando questa opzione è selezionata, i generatori di DIBA vengono
eseguiti in una finestra di console visibile, che potrebbe essere necessaria se il plugin generatore è fornito di
una interfaccia grafica utente.

Script di generazione DIBA
By default, the BOM tool presents two output script options.

bom_csv_grouped_by_value  outputs a CSV with two sections. The first section contains every
component in the design, with a single component on each line. The second section also contains every
component, but components are grouped by symbol name, value, and footprint. The columns in the BOM

are:

Line item number

Quantità

Riferimenti

Valore

Libreria di simboli e nome simbolo

Impronta

Datasheet

Qualsiasi altro campo del simbolo

bom_csv_grouped_by_value_with_fp  outputs a CSV with a single section containing every component in

the design. Components are grouped by value and footprint. The columns in the BOM are:

Riferimenti

Quantità

Valore

Nome simbolo

Impronta

Descrizione simbolo

Marchio

Additional generator scripts are installed with KiCad but are not populated in the generator script list by

default. The location of these scripts depends on the operating system and may vary based on installation
location.
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Operating System Location

Windows C:\Program Files\KiCad\6.0\bin\scripting\plugins\

Linux /usr/share/kicad/plugins/

macOS /Applications/KiCad/KiCad.app/Contents/SharedSupport/plugins/

Ulteriori script possono essere aggiunti all’elenco degli script del generatore DIBA facendo clic sul pulsante 
. Gli script possono essere rimossi facendo clic sul pulsante . Il pulsante  apre lo script selezionato in

un editor di testo.

For more information on creating and using custom BOM generators, see the advanced documentation.

Netlist
Una netlist è un file che descrive le connessioni elettriche tra i pin dei simboli. Queste connessioni sono
chiamate net o collegamenti. I file netlist contengono:

Un elenco di simboli e dei loro pin.

L’elenco delle connessioni (net) tra pin di simboli.

Esistono diversi formati di netlist. A volte, l’elenco simboli e l’elenco dei collegamenti, sono due file separati.
La netlist è fondamentale per uso di software di progettazione elettronica, dato che la netlist è anche un
mezzo di collegamento con gli altri software di CAD elettronico, come software di progettazione circuiti
stampati, simulatori e compilatori di logiche programmabili.

KiCad supporta diversi formati di netlist:

KiCad format, which can be imported by the KiCad PCB Editor. However, the "Update PCB from
Schematic" tool should be used instead of importing a KiCad netlist into the PCB editor.

Formato OrCAD PCB2, per progettare circuiti stampati con OrCAD.

Formato CADSTAR, per progettare circuiti stampati con CADSTAR.

Formato Spice, per l’uso di vari simulatori esterni di circuiti elettronici.

NOTE
In KiCad version 5.0 and later, it is not necessary to create a netlist
 for transferring a
design from the schematic editor to the PCB editor.
Instead, use the
"Update PCB from
Schematic" tool.

NOTE

Other software tools that use netlists may have restrictions on spaces and
 special
characters in component names, pins, nets, and other fields. For
compatibility, be aware of
such restrictions in other tools you plan to
 use, and name components, nets, etc.
accordingly.

Formati di netlist
Netlists are exported with the Export Netlist dialog (File→Export→Netlist…​).
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KiCad supports exporting netlists in several formats: KiCad, OrcadPCB2, CADSTAR, and Spice. Each format
can be selected by selecting the corresponding tab at the top of the window. Some netlist formats have
additional options.

Clicking the Export Netlist button prompts for a netlist filename and saves the netlist.

NOTE La generazione della netlist può impiegare diversi minuti con schemi elettrici estesi.

Custom generators for other netlist formats can be added by clicking the Add Generator…​ button. Custom
generators are external tools that are called by KiCad, for example Python scripts or XSLT stylesheets. For

more information on custom netlist generators, see the section on adding custom netlist generators.

Formati netlist Spice

Il formato netlist Spice offre diverse opzioni.

When the Reformat passive symbol values box is checked, passive symbol values will be adjusted to be

compatible with Spice. Specifically:

μ  and M  as unit prefixes are replaced with u  and Meg , respectively
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Units are removed (e.g. 4.7kΩ  is changed to 4.7k )

Values in RKM format are rewritten to be Spice-compatible (e.g. 4u7  is changed to 4.7u )

The Spice netlist exporter also provides an easy way to simulate the generated netlist with an external
simulator. This can be useful for running a simulation without using KiCad’s internal ngspice simulator, or
for running an ngspice simulation with options that are not supported by KiCad’s simulator tool.

Enter the path to the external simulator in the text box, with %I  representing the generated netlist. Click

the Create Netlist and Run Simulator Command button to generate the netlist and automatically run the
simulator.

NOTE The default simulator command ( spice "%I" ) must be adjusted to point to a simulator
installed on your system.

Spice simulators expect simulation commands ( .PROBE , .AC , .TRAN , etc.) to be included in the netlist. Any
text line included in the schematic diagram starting with a period ( . ) will be included in the netlist. If a text
object contains multiple lines, only the lines beginning with a period will be included.

.include  directives for including model library files are automatically added to the netlist based on the

Spice model settings for the symbols in the schematic.

Esempi netlist
Below is the schematic from the sallen_key  project included in KiCad’s simulation demos.

La netlist in formato KiCad per questo schema è la seguente:
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(export (version "E")

  (design

    (source "/usr/share/kicad/demos/simulation/sallen_key/sallen_key.kicad_sch")

    (date "Sun 01 May 2022 03:14:05 PM EDT")

    (tool "Eeschema (6.0.4)")

    (sheet (number "1") (name "/") (tstamps "/")

      (title_block

        (title)

        (company)

        (rev)

        (date)

        (source "sallen_key.kicad_sch")

        (comment (number "1") (value ""))

        (comment (number "2") (value ""))

        (comment (number "3") (value ""))

        (comment (number "4") (value ""))

        (comment (number "5") (value ""))

        (comment (number "6") (value ""))

        (comment (number "7") (value ""))

        (comment (number "8") (value ""))

        (comment (number "9") (value "")))))

  (components

    (comp (ref "C1")

      (value "100n")

      (libsource (lib "sallen_key_schlib") (part "C") (description ""))

      (property (name "Sheetname") (value ""))

      (property (name "Sheetfile") (value "sallen_key.kicad_sch"))

      (sheetpath (names "/") (tstamps "/"))

      (tstamps "00000000-0000-0000-0000-00005789077d"))

    (comp (ref "C2")

      (value "100n")

      (fields

        (field (name "Fieldname") "Value")

        (field (name "SpiceMapping") "1 2")

        (field (name "Spice_Primitive") "C"))

      (libsource (lib "sallen_key_schlib") (part "C") (description ""))

      (property (name "Fieldname") (value "Value"))

      (property (name "Spice_Primitive") (value "C"))

      (property (name "SpiceMapping") (value "1 2"))

      (property (name "Sheetname") (value ""))

      (property (name "Sheetfile") (value "sallen_key.kicad_sch"))

      (sheetpath (names "/") (tstamps "/"))

      (tstamps "00000000-0000-0000-0000-00005789085b"))

    (comp (ref "R1")

      (value "1k")

      (fields

        (field (name "Fieldname") "Value")

        (field (name "SpiceMapping") "1 2")

        (field (name "Spice_Primitive") "R"))

      (libsource (lib "sallen_key_schlib") (part "R") (description ""))

      (property (name "Fieldname") (value "Value"))

      (property (name "SpiceMapping") (value "1 2"))

      (property (name "Spice_Primitive") (value "R"))

      (property (name "Sheetname") (value ""))

      (property (name "Sheetfile") (value "sallen_key.kicad_sch"))

      (sheetpath (names "/") (tstamps "/"))

      (tstamps "00000000-0000-0000-0000-0000578906ff"))

    (comp (ref "R2")

      (value "1k")

      (fields
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In formato Spice, la netlist è la seguente:

.title KiCad schematic


.include "ad8051.lib"

XU1 Net-_C2-Pad1_ /lowpass VDD VSS /lowpass AD8051

C2 Net-_C2-Pad1_ GND 100n

C1 /lowpass Net-_C1-Pad2_ 100n

R2 Net-_C2-Pad1_ Net-_C1-Pad2_ 1k

R1 Net-_C1-Pad2_ Net-_R1-Pad2_ 1k

V1 Net-_R1-Pad2_ GND AC 1

V2 VDD GND DC 10

V3 GND VSS DC 10

.ac dec 10 1 1Meg

.end
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Gestione librerie di simboli
Le librerie di simboli contengono raccolte di simboli utilizzati durante la creazione degli schemi elettrici.
Ogni simbolo in uno schema è identificato in modo univoco da un nome completo composto da un nickname
di libreria e da un nome di simbolo. Un esempio è Audio: AD1853 .

Tabella librerie di simboli
KiCad uses a table of symbol libraries to map symbol libraries to a library nickname. Kicad uses a global

symbol library table as well as a table specific to each project. To edit either symbol library table, use
Preferences → Manage Symbol Libraries…​.

La tabella delle librerie simboli globali contiene l’elenco delle librerie sempre disponibili
indipendentemente dal progetto attualmente caricato. La tabella viene salvata nel file sym-lib-table  nella

cartella di configurazione di KiCad. La posizione di questa cartella dipende dal sistema operativo utilizzato.

La tabella della libreria dei simboli specifica del progetto contiene l’elenco delle librerie che sono disponibili
specificamente per il progetto attualmente caricato. Se sono presenti librerie di simboli specifiche del

progetto, la tabella viene salvata nel file sym-lib-table  nella cartella del progetto.

Configurazione iniziale
The first time the KiCad Schematic Editor is run and the global symbol table file sym-lib-table  is not found
in the KiCad configuration folder, KiCad will guide the user through setting up a new symbol library table.

file:///src/build/src/eeschema/kicad/kicad.html#config-file-location
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This process is described above.

Gestione voci della tabella
Symbol libraries can only be used if they have been added to either the global or project-specific symbol
library table.

Aggiungere una libreria facendo clic sul pulsante  selezionando una libreria o facendo clic sul pulsante 
e digitando il percorso di un file di libreria . La libreria selezionata verrà aggiunta alla tabella della libreria
attualmente aperta (globale o specifica del progetto). Le librerie possono venir rimosse selezionando le voci

della libreria desiderate e facendo clic sul pulsante .

The  and  buttons move the selected library up and down in the library table. This does not affect the
display order of libraries in the Symbol Library Browser, Symbol Editor, or Add Symbol tool.

Libraries can be made inactive by unchecking the Active checkbox in the first column. Inactive libraries are

still in the library table but do not appear in any library browsers and are not loaded from disk, which can
reduce loading times.

A range of libraries can be selected by clicking the first library in the range and then -clicking the last
library in the range.

Each library must have a unique nickname: duplicate library nicknames are not allowed in the same table.
However, nicknames can be duplicated between the global and project library tables. Libraries in the project
table take precedence over libraries with the same name in the global table.

Gli identificatori di libreria non devono essere correlati al nome file o al percorso della libreria. Il carattere

due punti ( : ) non può essere utilizzato negli identificatori di libreria o nei nomi dei simboli perché viene
utilizzato come separatore tra identificatori e simboli.

Each library entry must have a valid path. Paths can be defined as absolute, relative, or by environment
variable substitution.

The appropriate library format must be selected in order for the library to be properly read. "KiCad" format
is used for KiCad version 6 libraries ( .kicad_sym  files), while "Legacy" format is used for libraries from
older versions of KiCad ( .lib  files). Legacy libraries are read-only, but can be migrated to KiCad format

libraries using the Migrate Libraries button (see section Migrating Legacy Libraries).

Esiste un campo optionale per la descrizione della voce di libreria. Il campo opzioni non viene usato al
momento perciò aggiungere opzioni non ha alcun effetto sul caricamento delle librerie.

Sostituzione delle variabili ambiente
Le tabelle delle librerie di simboli supportano la sostituzione delle variabili ambiente, che consente di

definire variabili ambiente contenenti percorsi personalizzati in cui sono archiviate le librerie. La
sostituzione delle variabili ambiente è supportata usando la sintassi ${ENV_VAR_NAME}  nel percorso della
libreria dei simboli.

Come impostazione predefinita, KiCad definisce diverse variabili ambiente:

${KIPROJMOD}  punta sempre alla cartella del progetto corrente e non può essere modificata.

${KICAD6_FOOTPRINT_DIR}  points to the default location of KiCad’s standard footprint libraries.

Shift
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${KICAD6_SYMBOL_DIR}  points to the default location of KiCad’s standard symbol libraries.

${KICAD6_3DMODEL_DIR}  points to the default location of KiCad’s standard 3D model libraries.

${KICAD6_TEMPLATE_DIR}  points to the default location of KiCad’s standard template library.

${KIPROJMOD}  cannot be redefined, but the other environment variables can be redefined and new
environment variables added in the Preferences → Configure Paths…​ dialog.

Using environment variables in the symbol library tables allows libraries to be relocated without breaking
the symbol library tables, so long as the environment variables are updated when the library location
changes.

${KIPROJMOD}  consente di memorizzare le librerie nella cartella del progetto senza dover usare un
percorso assoluto nella tabella librerie del progetto. Ciò consente di riposizionare i progetti mantenendo
valida la tabella librerie del progetto. Una delle funzionalità più potenti della tabella librerie di simboli è la
sostituzione delle variabili ambiente. Ciò consente la definizione di percorsi personalizzati nei quali (N.d.T. i

percorsi) delle librerie di simboli vengono inseriti nelle variabili ambiente. La sostituzione delle variabili
ambiente è supportata usando la sintassi ${NOME_VAR_AMB}  nel percorso della libreria.

Modelli di utilizzo
Le librerie di simboli si possono definire sia globalmente che specificatamente al progetto correntemente
caricato. Le librerie di simboli definite nella tabella globale dell’utente sono sempre disponibili e vengono

memorizzate nel file sym-lib-table  nella cartella di configurazione di KiCad dell’utente. La tabella delle
librerie di simboli specifica del progetto è attiva solamente per il file progetto aperto al momento.

Ci sono vantaggi e svantaggi per ogni metodo. Definire tutte le librerie nella tabella globale significa che
queste saranno sempre disponibili alla bisogna. Lo svantaggio di ciò è aumenterà che il tempo di

caricamento.

Definire tutte le librerie di simboli su base specifica del progetto significa che si avranno solamente le
librerie necessarie per quel progetto e ciò diminuirà il tempo di caricamento dei simboli. Lo svantaggio è che
sarà sempre necessario ricordarsi di aggiungere ogni libreria di simboli necessaria per ogni progetto.

Uno schema di utilizzo potrebbe essere quello di definire le librerie di uso comune a livello globale e le
librerie richieste solo per il progetto nella tabella della libreria specifica del progetto.

Migrazione delle librerie obsolete
Legacy libraries ( .lib  files) are read-only, but they can be migrated to KiCad version 6 libraries
( .kicad_sym ). KiCad version 6 libraries cannot be viewed or edited by KiCad versions older than 6.0.0.

Legacy libraries can be converted to KiCad 6 libraries by selecting them in the symbol library table and
clicking the Migrate Libraries button. Multiple libraries can be selected and migrated at once by -
clicking or -clicking.

Libraries can also be converted one at a time by opening them in the Symbol Editor and saving them as a

new library.

Ctrl

shift
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Rimappatura dei vecchi progetti
Quando si carica uno schema creato prima dell’implementazione della tabella delle librerie di simboli, KiCad
cercherà di rimappare i collegamenti alle librerie di simboli presenti nello schema ai simboli nella tabella
librerie appropriati. Il successo di questo processo dipende da diversi fattori:

le librerie originali usate nello schema sono ancora disponibili e invariate da quando il simbolo è stato

aggiunto allo schema.

tutte le operazioni di salvataggio sono state eseguite quando sono state rilevate per creare una libreria

di salvataggio o mantenere aggiornata la libreria di salvataggio esistente.

l’integrità della libreria cache dei simboli del progetto non è stata danneggiata.

WARNING

La rimappatura eseguirà un salvataggio di tutti i file che vengono modificati durante
l’operazione, nella cartella di salvataggio all’interno della cartella del progetto. Effettuare

sempre un salvataggio del progetto prima di rimappare, (N.d.T. per evitare brutte
sorprese) nel caso in cui qualcosa vada storto.

WARNING

L’operazione di recupero viene eseguita anche se è stata disabilitata per garantire che i
simboli corretti siano disponibili per la rimappatura. Non annullare questa operazione o
la rimappatura non riuscirà a rimappare correttamente i simboli degli schemi. Eventuali
collegamenti a simboli spezzati dovranno essere corretti manualmente.

NOTE

Se le librerie originali sono state rimosse e il recupero non è stato eseguito, la cache della
libreria può essere utilizzata come libreria di ripristino come ultima risorsa. Copiare la

libreria della cache in un nuovo nome file e aggiungere il nuovo file della libreria all’inizio
dell’elenco delle librerie usando una versione di KiCad precedente all’implementazione
della tabella della libreria dei simboli.
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Editor dei simboli
Informazioni generali sulle librerie di simboli
Un simbolo è un elemento dello schema elettrico che contiene una rappresentazione grafica, connessioni
elettriche e campi di testo che definiscono il simbolo stesso. I simboli usati in uno schema elettrico vengono
memorizzati in librerie di simboli. KiCad fornisce uno strumento per la modifica dei simboli che permette di
creare librerie, aggiungere, eliminare o trasferire simboli tra librerie, esportare simboli su file e importare

simboli da file. In breve, lo strumento di modifica dei simboli fornisce un modo semplice per gestire simboli
e librerie di simboli.

Panoramica delle librerie di simboli
Una libreria di simboli è composta da uno o più simboli. Generalmente i simboli sono raggruppati per
funzione, tipo e/o produttore.

Un simbolo è composto di:

Elementi grafici (linee, cerchi, archi, testo, ecc.) che determinano l’aspetto del simbolo nello schema
elettrico.

I piedini hanno sia proprietà grafiche (linea, clock, inversione, attivo basso, ecc.) che proprietà elettriche
(ingresso, uscita, bidirezionale, ecc.) usate dallo strumento di controllo regole elettriche (ERC).

Campi come riferimenti, valori, nomi impronte corrispondenti per la progettazione del circuito
stampato, ecc.

I simboli possono essere derivati da un altro simbolo nella stessa libreria. I simboli derivati condividono la
forma grafica e le definizioni dei pin del simbolo di base, ma possono sovrascrivere i campi delle proprietà

del simbolo di base (valore, impronta, filtri impronta, documentazione, descrizione, ecc.). I simboli derivati
possono essere utilizzati per definire simboli simili ad una parte di base. Ad esempio, i simboli 74LS00,
74HC00 e 7437 potrebbero essere tutti derivati da un simbolo 7400. Nelle versioni precedenti di KiCad, i
simboli derivati erano chiamati alias.

La corretta progettazione di simboli richiede:

Specificare se il simbolo è formato da più di un’unità.

Specificare se il simbolo possiede uno stile corpo alternativo (altrimenti detto rappresentazione De
Morgan).

La progettazione della sua rappresentazione simbolica usando linee, rettangoli, cerchi, poligoni e testo.

L’aggiunta di pin definendo con cura l’elemento grafico di ogni pin, il nome, il numero, e le sue proprietà

elettriche (ingresso, uscita, tri-state, potenza, ecc.).

Determining if the symbol should be derived from another symbol with the same graphical design and

pin definition.

L’aggiunta di campi opzionali come il nome dell’impronta usata dal software di progettazione di circuiti

stampati e/o la definizione della loro visibilità.

La documentazione del simbolo aggiungendo una stringa di descrizione, collegamenti ai datasheet, ecc.
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Il salvataggio nella libreria scelta.

Panoramica dell’editor dei simboli di libreria
Di seguito si può osservare la finestra principale dell’editor di librerie di simboli. Esso consiste in tre barre
degli strumenti che servono a velocizzare l’accesso alle funzioni più comuni, e un’area di

visualizzazione/modifica del simbolo. Sulle barre degli strumenti non sono disponibili tutti comandi, ma
quelli che mancano sono comunque accessibili tramite i menu.

Barra strumenti principale
La barra degli strumenti principale è collocata in cima alla finestra principale, come mostrato sotto, e
consiste nei comandi di annullamento e ripetizione delle ultime operazioni, zoom, finestre di dialogo delle
proprietà dei simboli, controlli di gestione unità/rappresentazione.
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Create a new symbol in the selected library.

Save the currently selected library. All modified symbols in the library will
be saved.

Undo last edit.

Redo last undo.

Refresh display.

Zoom in.

Zoom out.

Zoom to fit symbol in display.

Zoom to fit selection.

Rotate counter-clockwise.

Rotate clockwise.

Mirror horizontally.

Mirror vertically.

Edit the current symbol properties.

Edit the symbol’s pins in a tablular interface.

Open the symbol’s datasheet. The button will be disabled if no datasheet is
defined
for the current symbol.

Test the current symbol for design errors.

Select the normal body style. The button is disabled if the current
symbol does not
have an alternate body style.

Select the alternate body style. The button is disabled if the current
symbol does not
have an alternate body style.

Select the unit to display. The drop down control will be disabled if
the current
symbol is not derived from a symbol with multiple units.

Enable synchronized pins edit mode. When this mode is enabled, any pin
modifications are propagated to all other symbol units. Pin number changes are
not
propagated. This mode is automatically enabled for symbols with multiple
interchangeable units and cannot be enabled for symbols with only one unit.

Insert current symbol into schematic.
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Barra strumenti elementi
La barra strumenti verticale sul lato destro della finestra principale permette di piazzare tutti gli elementi
richiesti per progettare un simbolo.

Strumento di selezione. Clic destro con lo strumento di selezione apre il
menu contestuale per
l’oggetto sottostante il puntatore. Clic sinistro con
lo strumento di selezione visualizza gli
attributi dell’oggetto nel pannello
messaggi in fondo alla finestra principale. Doppio clic

sinistro con lo
strumento di selezione apre la finestra di dialogo delle proprietà dello
stesso
oggetto.

Strumento pin. Clic sinistro per aggiungere un nuovo piedino.

Strumento testo grafico. Clic sinistro per aggiungere un nuovo elemento di testo grafico.

Strumento rettangolo. Clic sinistro per cominciare a disegnare il primo
vertice di un rettangolo
grafico. Un secondo clic sinistro per piazzare
il vertice opposto del rettangolo.

Strumento cerchio. Clic sinistro per cominciare a disegnare un nuovo cerchio
grafico dal
centro. Un secondo clic sinistro imposta il raggio del cerchio.

Strumento arco. Clic sinistro per cominciare a disegnare un nuovo elemento
arco grafico dal
primo capo. Altro clic sinistro per impostare il secondo capo.
Per regolare il raggio trascinare il
punto di centro dell’arco.

Strumento linea connessa. Clic sinistro per cominciare a disegnare un nuovo elemento
grafico
linea nel simbolo corrente. Clic sinistro per ogni linea connessa aggiuntiva.
Doppio clic sinistro
per completare la linea.

Strumento àncora. Clic sinistro per impostare la posizione dell’àncora del simbolo.

Strumento elimina. Clic sinistro per eliminare un oggetto dal simbolo corrente.

Barra opzioni
La barra strumenti verticale, posizionata sul lato sinistro della finestra principale, permette di impostare

alcune opzioni di disegno dell’editor.
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Commuta la visibilità griglia.

Imposta le unità a pollici.

Imposta le unità a mils (0.001 pollici).

Imposta le unità a millimetri.

Commuta la forma del puntatore (pieno schermo/piccolo).

Commuta la visibilità della tipologia elettrica dei pin.

Commuta la visibilità delle librerie e dei simboli.

Selezione e manutenzione librerie
La selezione della libreria corrente è possibile tramite l’icona  che mostra tutte le librerie disponibili e

permette di selezionarne una. Quando un simbolo viene caricato o salvato, esso viene messo in questa
libreria. Il nome di libreria di un simbolo è il contenuto del suo campo valore.

Selezione e salvataggio di un simbolo

Selezione simboli
Facendo clic sull’icona  sulla barra degli strumenti di sinistra commuta la visualizzazione ad albero di

librerie e simboli. Facendo clic su un simbolo si apre quel simbolo.

NOTE

Alcuni simboli sono derivati da altri simboli. I nomi dei simboli derivati vengono
visualizzati in corsivo nella vista ad albero. Se un simbolo derivato viene aperto, la sua
grafica non sarà modificabile. I suoi campi simbolo invece saranno modificabili
normalmente. Per modificare la grafica di un simbolo base e di tutti i suoi simboli
derivati, bisogna aprire il simbolo base.

Salvare un simbolo
Dopo la modifica, un simbolo può essere salvato nella libreria corrente o in una nuova libreria.

Per salvare il simbolo modificato nella libreria corrente, fare clic sull’icona . Le modifiche verranno

scritte sul simbolo esistente.

NOTE Saving a modified symbol also saves all other modified symbols in the same library.

Per salvare i cambiamenti del simbolo in un nuovo simbolo, fare clic su File → Salva con nome…​. Il simbolo
può essere salvato nella libreria corrente o in una diversa libreria. Si può impostare anche un nuovo nome
per il simbolo.

Per creare un nuovo file contenente solo il simbolo corrente, fare clic su File → Esporta → Simbolo…​.
Questo file sarà un file di libreria standard che conterrà solo un simbolo.
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Creare simboli di libreria

Creare un nuovo simbolo
Un nuovo simbolo può essere creato facendo clic sull’icona . Verranno richieste un certo numero di

proprietà del simbolo.

Un nome simbolo (questo nome viene usato come valore predefinito del campo Valore  nell’editor dello
schema elettrico.

An optional base symbol to derive the new symbol from. The new symbol will use the base symbol’s
graphical shape and pin configuration, but other symbol information can be modified in the derived

symbol. The base symbol must be in the same library as the new derived symbol.

Il prefisso del riferimento ( U , C , R…​).

The number of units per package, and whether those units are interchangeable (for example a 7400 is
made of 4 units per package).

If an alternate body style (sometimes referred to as a "De Morgan equivalent") is desired.

Whether the symbol is a power symbol. Power symbols appear in the "Add Power Port" dialog in the
Schematic editor, their Value  fields are not editable in the schematic, they cannot be assigned a
footprint and they are not added to the PCB, and they are not included in the bill of materials.

Whether the symbol should be excluded from the bill of materials.

Whether the symbol should be excluded from the PCB.

There are also several graphical options.

The offset between the end of each pin and its pin name.

Whether the pin number and pin name should be displayed.

Whether the pin names should be displayed alongside the pins or at the ends of the pins inside the
symbol body.

These properties can also be changed later in the Symbol Properties window.
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Un nuovo simbolo verrà creato usando le proprietà sopraesposte e apparirà nell’editor come mostrato
sotto.
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The blue cross in the center is the symbol anchor, which specifies the symbol origin i.e. the coordinates (0, 0).

The anchor can be repositioned by selecting the  icon and clicking on the new desired anchor position.

Creare un simbolo da un altro simbolo
Spesso, il simbolo che si vuole creare è simile ad un altro già presente in una libreria componenti. In questo
caso risulta più facile caricare e modificare un simbolo esistente (N.d.T. piuttosto che ricrearne uno nuovo da

zero).

Caricare il simbolo che verrà usato come punto di partenza.

Save a new copy of the symbol using File → Save As…​. The Save As dialog will prompt for a name for the
new symbol and the library to save it in.

Modifica il nuovo simbolo come richiesto.

Salva il simbolo modificato.

Proprietà del simbolo
Le proprietà del simbolo vengono impostate durante la creazione del simbolo ma queste possono essere

modificate in qualsiasi momento. Per cambiare le proprietà del simbolo, fare clic su  per mostrare la

finestra seguente.

È molto importante impostare correttamente il numero di unità per contenitore e la rappresentazione

simbolica alternativa, se abilitata, perché quando i pin vengono modificati o creati, sono coinvolti i pin
corrispondenti per ogni unità. Se si cambia il numero di unità per contenitore dopo la creazione e modifica
dei pin, ci sarà ulteriore lavoro per specificare i pin e le grafiche per le nuove unità. Comunque, è possibile

modificare queste proprietà in ogni momento.
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Le opzioni grafiche "Mostra numero piedino" e "Mostra nome piedino" definiscono la visibilità del numero
piedino e del testo del nome del piedino. L’opzione "Nome piedino interno" imposta la posizione del nome

del piedino relativamente al corpo del piedino. I nomi dei pin verranno mostrati all’interno del bordo del
simbolo se l’opzione è stata spuntata. In questo caso la proprietà "Scostamento nome piedino" definisce lo
spostamento del testo dalla fine del corpo del piedino. Un valore da 0.02 a 0.05 pollici è solitamente
ragionevole.

L’esempio sottostante mostra un simbolo con l’opzione ``Nome piedino interno'' non selezionata. Si noti la
posizione dei nomi e dei numeri di pin.

Nome simbolo, descrizione, e parolechiave
The symbol’s name is the same as the Value  field. When the symbol name is changed the value also changes,
and vice versa. The symbol’s name in the library also changes accordingly.

The symbol description should contain a brief description of the component, such as the component
function, distinguishing features, and package options. The keywords should contain additional terms
related to the component. Keywords are used primarily to assist in searching for the symbol.
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A symbol’s name, description, and keywords are all used when searching for symbols in the Symbol Editor
and Add a Symbol dialog. The description and keywords are displayed in the Symbol Library Browser and
Add a Symbol dialog.

Filtri impronte
The footprint filters tab is used to define which footprints are appropriate to use with the symbol. The
filters can be applied in the Footprint Assignment tool so that only appropriate footprints are displayed for
each symbol.

Multiple footprint filters can be defined. Footprints that match any of the filters will be displayed; if no
filters are defined, then all footprints will be displayed.

Filters can use wildcards: *  matches any number of characters, including zero, and ?  matches zero or one

characters. For example, SOIC-*  would match the SOIC-8_3.9x4.9mm_P1.27mm  footprint as well as any
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other footprint beginning with SOIC- . The filter SOT?23  matches SOT23  as well as SOT-23 .

Definizione piedini per simboli multipli e rappresentazioni simboliche
alternative
Se il simbolo possiede uno stile corpo alternativo definito, sarà necessario selezionarne uno alla volta per la

modifica. Per modificare la rappresentazione normale, fare clic su .

Per modificare la rappresentazione alternativa fare clic su . Usare  a discesa mostrata

sotta per selezionare l’unità che si desidera modificare.

Elementi grafici
Gli elementi grafici formano la rappresentazione di un simbolo e non contengono informazioni di
connessioni elettriche. Vengono creati usando i seguenti strumenti:
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Linee e poligoni definiti da punti di inizio e fine.

Rettangoli definiti da due angoli diagonali.

Cerchi definiti da centro e raggio.

Archi definiti da punti di inizio e fine dell’arco ed il suo centro. Un arco va da 0° a 180°.

La barra strumenti verticale sul lato destro della finestra principale permette di piazzare tutti gli elementi
grafici richiesti per progettare la rappresentazione di un simbolo.

Appartenenza di elementi grafici
Ogni elemento grafico (linea, arco, cerchio, ecc.) può essere definito come comune a tutte le unità e/o stili di

corpi o specifico di una data unità e/o stile corpo. Le opzioni dell’elemento sono accessibili facilmente
facendo clic destro sull’elemento per mostrare il menu contestuale per l’elemento selezionato. Di seguito è
mostrato il menu contestuale per un elemento linea.

Si può anche fare doppio clic sinistro su un elemento per modificare le sue proprietà. Di seguito viene

mostrata la finestra di dialogo delle proprietà di un elemento poligono.
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Le proprietà di un elemento grafico sono:

"Spessore linea" definisce lo spessore della linea dell’elemento nelle unità di disegno corrente.

Lo "Stile di riempimento" determina se la forma definita dall’elemento grafico deve essere disegnata non

riempita, riempita con lo sfondo o riempita con il primo piano.

L’impostazione "Comune a tutte le unità nel simbolo" definisce se l’elemento grafico deve essere

disegnato per ogni unità nel simbolo con più di una unità per contenitore o se l’elemento grafico deve
essere disegnato solo per l’unità corrente.

L’impostazione "Comune a tutti gli stili di corpi (DeMorgan)" determina se l’elemento grafico deve essere
disegnato per ogni rappresentazione dei simboli con uno stile di corpo alternativo o se l’elemento
grafico deve essere disegnato solo per lo stile di corpo corrente.

Elementi di testo grafico
 permette la creazione di testo grafico. Il testo grafico viene automaticamente orientato per essere

leggibile, anche se il simbolo viene reso speculare. Si noti che gli elementi di testo grafico non sono campi del
simbolo.

Unità multiple per simbolo e stili di corpo alternativi
I simboli possono avere fino a due rappresentazioni simboliche (una standard e una alternativa, spesso
chiamata "equivalente DeMorgan") e/o avere più di una unità per contenitore (per esempio le porte logiche).
Alcuni simboli possono avere più di una unità per ogni contenitore con simboli e configurazioni di
piedinatura differenti.

Si consideri per esempio un relè con due interruttori che può essere creato come un simbolo composto di tre
diverse unità: una bobina, un interruttore 1, e un interruttore 2. Progettare un simbolo con unità multiple
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per contenitore e/o stili di corpo alternativi è molto flessibile. Un pin o un elemento simbolico di corpo
possono essere comuni a tutte le unità o specifici di una data unità o ancora possono essere comuni sia a

entrambe le rappresentazioni simboliche che essere specifici di una data rappresentazione simbolica.

Come impostazione predefinita, i pin sono specifici ad una unità e stile di corpo. Quando un pin è comune ad
ogni unità o stile di corpo, è necessario crearlo solo una volta. Ciò accade anche per le forme grafiche e il
testo dello stile del corpo, che possono essere comuni per ogni unità ma tipicamente sono specifiche per

ogni rappresentazione simbolica.

Esempio di simbolo multiunità non interscambiabili
Come esempio di simbolo con più unità non intercambiabili, si consideri un relè con 3 unità per contenitore:
una bobina, l’interruttore 1 e l’interruttore 2.

Le tre unità non sono tutte uguali, quindi "Tutte le unità sono intercambiabili" dovrebbe essere

deselezionato nella finestra di dialogo Proprietà simbolo. In alternativa, questa opzione potrebbe essere
stata specificata quando il simbolo è stato inizialmente creato.
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Unità A

Unità B

Unità C

L’unità A non ha lo stesso simbolo e disposizione di pin delle unità B e C, perciò le unità non sono
intercambiabili.
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NOTE

"Synchronized Pins Edit Mode" can be enabled by clicking the  icon. In this mode, pin
modifications are propagated between symbol units; changes made in one unit will be
reflected in the other units as well. When this mode is disabled, pin changes made in one
unit do not affect other units. This mode is enabled automatically when "All units are
interchangeable" is checked, but it can be disabled. The mode cannot be enabled when "All
units are interchangeable" is unchecked or when the symbol only has one unit.

Elementi simbolici grafici
In basso le proprietà di un elemento per un corpo grafico. Nell’esempio precedente del relè, le tre unità
hanno rappresentazioni simboliche differenti. Perciò, ogni unità è stata creata separatamente e gli elementi

del corpo grafico devono avere l’impostazione "Comune a tutte le unità nel simbolo" disabilitata.

Creazione e modifica di piedini
Si può fare clic sull’immagine  per creare e inserire un pin. La modifica di tutte le proprietà del pin viene

fatta facendo doppio clic sul pin o facendo clic destro sul pin per aprire il menu contestuale del pin. I pin si
devono creare con attenzione, dato che ogni errore avrà conseguenze sul circuito stampato in
progettazione. Ogni pin già posizionato può essere modificato, cancellato e/o spostato.

Panoramica piedino
Un piedino viene definito dalla sua rappresentazione grafica, il suo nome ed il suo numero. Il nome e il

numero del piedino può contenere lettere, numeri e simboli ma non spazi. Perché lo strumento di controllo
regole elettriche (ERC) sia utile, i piedini di tipo elettrico (ingresso, uscita, tri-state…​) devono anch’essi
essere definiti correttamente. Se i piedini di questo tipo non sono definiti correttamente, i risultati del
controllo elettrico ERC potrebbero non essere validi.

Note importanti:
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Symbol pins are matched to footprint pads by number. The pin number in the symbol must match the
corresponding pad number in the footprint.

Do not use spaces in pin names and numbers. Spaces will be automatically replaced with underscores
( _ ).

Per definire un nome pin con un segnale invertito (overline) usare il carattere ~  (tilde) seguito dal testo
da invertite in parentesi graffe. Per esempio \~{FO}O  mostrerà FO O.

Se il nome pin è vuoto, il pin viene considerato senza nome.

I nomi di pin possono essere ripetuti in un simbolo.

I numeri di pin devono essere univoci in un simbolo.

Proprietà piedino

La finestra di dialogo delle proprietà del pin permette di modificare tutte le caratteristiche di un pin. Questa

finestra di dialogo salta fuori automaticamente quando si crea un pin o facendo doppio clic su un pin già
esistente. Questa finestra di dialogo permette di modificare:

Nome e dimensione testo del pin.

Numero e dimensione testo del pin.

Lunghezza pin.

Tipo elettrico e stile grafico del piedino.

Unità e appartenenza a rappresentazioni alternative.

Visibilità pin.

Definizioni alternative del pin.
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Stili grafici pin
Mostrati nella figura sottostante ci sono differenti stili di rappresentazione grafica del pin. La scelta dello
stile grafico non ha influenza sul tipo elettrico del pin.

Tipi elettrici del pin
Choosing the correct electrical type is important for the schematic ERC tool. ERC will check that pins are

connected appropriately, for example ensuring that input pins are driven and power inputs receive power
from an appropriate source.
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Pin Type Description

Input A pin which is exclusively an input.

Output A pin which is exclusively an output.

Bidirectional A pin that can be either an input or an output, such as a
microcontroller data
bus pin.

Tri-state A three state output pin (high, low, or high impedance)

Passive A passive symbol pin: resistors, connectors, etc.

Free A pin that can be freely connected to any other pin without electrical
concerns.

Unspecified A pin for which the ERC check does not matter.

Power input A symbol’s power pin. As a special case, power input pins that
are marked
invisible are automatically connected to the net with the same name.
See the
Power Ports section for more information.

Power output A pin that provides power to other pins, such as a regulator
output.

Open collector An open collector logic output.

Open emitter An open emitter logic output.

Unconnected A pin that should not be connected to anything.

Pushing Pin Properties to Other Pins
You can apply the length, name size, or number size of a pin to the other pins in the symbol by right clicking

the pin and selecting Push Pin Length, Push Pin Name Size, or Push Pin Number Size, respectively.

Definizione piedini per componenti multipli e rappresentazioni
simboliche alternative
I simboli con più unità e/o rappresentazioni grafiche sono particolarmente problematici durante la
creazione e la modifica dei pin. La maggior parte dei pin è specifica per ciascuna unità di simbolo (perché

ogni unità ha un diverso set di pin) e per ogni stile del corpo (perché la forma e la posizione sono diverse tra
lo stile del corpo normale e la forma alternativa).
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L’editor della libreria dei simboli consente la creazione simultanea di pin. Per impostazione predefinita, le
modifiche apportate a un pin vengono apportate per tutte le unità di un simbolo a più unità e ad entrambe le

rappresentazioni per i simboli con una rappresentazione simbolica alternativa. L’unica eccezione è il tipo
grafico e il nome del pin, che rimangono scollegati tra le unità dei simboli e gli stili del corpo. Questa
dipendenza è stata stabilita per consentire una più facile creazione e modifica dei pin nella maggioranza dei

casi. Questa dipendenza può essere disabilitata attivando l’icona  sulla barra degli strumenti principale.

Ciò consentirà di creare pin per ogni unità e rappresentazione in modo completamente indipendente.

I pin possono essere comuni o specifici per diverse unità. I pin possono anche essere comuni a entrambe le
rappresentazioni simboliche o specifici di ciascuna rappresentazione simbolica. Quando un pin è comune a
tutte le unità, deve essere disegnato solo una volta. I pin sono impostati come comuni o specifici nella
finestra di dialogo delle proprietà dei pin.

Un esempio sono i pin di uscita del 7400, una porta NAND quadrupla a ingresso doppio. Dato che ci sono
quattro unità e due rappresentazioni simboliche, ci sono otto distinti piedini d’uscita descritti nella
definizione del simbolo. Durante la creazione di un nuovo componente 7400, l’unità A della
rappresentazione simbolica normale viene mostrata nell’editor di libreria. Per modificare lo stile del

piedino nella rappresentazione simbolica alternativa, questa deve prima essere abilitata facendo clic sul

pulsante  sulla barra degli strumenti. Per modificare il numero di pin per ogni unità, selezionare l’unità

appropriata usando il menu a discesa .

Tabella pin
Un altro modo per modificare i pin è usando la tabella pin, che è accessibile tramite l’icona . La tabella

pin mostra tutti i pin nel simbolo e le relative proprietà in una vista tabellare, quindi è utile per apportare
modifiche in blocco ai pin.

Qualsiasi proprietà del pin può essere modificata facendo clic sulla cella appropriata. I pin possono essere

aggiunti e rimossi rispettivamente con le icone  e .

NOTE
Le colonne della tabella pin possono essere visualizzate o nascoste facendo clic con il
pulsante destro del mouse sulla riga dell’intestazione e selezionando o deselezionando le
colonne aggiuntive. Alcune colonne sono nascoste per impostazione predefinita.

Lo screenshot qui sotto mostra la tabella pin per un operazionale quadruplo.
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Definizioni alternative dei pin
Ai pin possono essere aggiunte definizioni alternative. Le definizioni di pin alternative consentono ad un
utente di selezionare un nome, un tipo elettrico e uno stile grafico diversi per pin, quando il simbolo viene

posizionato sullo schema. Tutto ciò può essere utile per i pin che hanno più funzioni, come i pin di un
microcontrollore.

Le definizioni di pin alternative vengono aggiunte con finestra di dialogo Proprietà pin come mostrato di
seguito. Ogni definizione alternativa contiene un nome pin, un tipo elettrico e uno stile grafico. Questo pin di

microcontrollore ha tutte le sue funzioni periferiche definite nel simbolo come nomi di pin alternativi.
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Le definizioni di pin alternative vengono selezionate nell’editor degli schemi una volta che il simbolo sia
stato inserito nello schema. Il pin alternativo viene assegnato nella scheda Assegnazioni pin alternativi della
finestra di dialogo Proprietà simbolo. Le definizioni alternative sono selezionabili nell’elenco a discesa nella
colonna Assegnazione alternativa.
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Campi del simbolo
All library symbols are defined with four default fields. The reference designator, value, footprint
assignment, and datasheet link fields are created whenever a symbol is created or copied. Only the reference
designator and value fields are required.

I simboli definiti nelle librerie sono in genere definiti solo con questi quattro campi predefiniti. Campi
aggiuntivi come fornitore, numero di parte, costo unitario, ecc. possono essere aggiunti ai simboli della
libreria, ma generalmente questo viene fatto nell’editor dello schema in modo che i campi aggiuntivi
possano essere applicati a tutti i simboli nello schema.

NOTE

A convenient way to create additional empty symbol fields is to use define field name
templates. Field name templates define empty fields that are added to each symbol when
it is inserted into the schematic. Field name templates can be defined globally (for all
schematics) in the Schematic Editor Preferences, or they can be defined locally (specific to
each project) in the Schematic Setup dialog.

Modifica campi del simbolo
Per modificare un campo simbolo esistente, fare clic destro sul testo del campo per mostrare il menu
contestuale mostrato sotto.
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Per aggiungere nuovi campi, eliminare campi facoltativi o modificare campi esistenti, utilizzare l’icona 

sulla barra degli strumenti principale per aprire la finestra di dialogo Proprietà simbolo.

I campi sono informazioni di testo associate al simbolo. Non bisogna confonderli con il testo che fa parte
della rappresentazione grafica del simbolo.

Note importanti:

La modifica del campo "Valore" cambia il nome del simbolo. Il nome del simbolo nella libreria cambierà
quando il simbolo verrà salvato.

La finestra di dialogo Proprietà simbolo deve essere utilizzata per modificare un campo vuoto o con
l’attributo invisibile abilitato poiché tali campi non possono essere clic-cati.

L’impronta viene definita come impronta assoluta utilizzando il formato LIBNAME:FOOTPRINTNAME  dove
LIBNAME  è il nome della libreria di impronte definita nella tabella della libreria di impronte (vedere la
sezione "Tabella librerie di impronte" nel manuale dell’Editor C.S.) e ` FOOTPRINTNAME` è il nome
dell’impronta nella libreria LIBNAME .

Creazione simboli porte di potenza
Le porte di potenza, o simboli di potenza, sono simboli utilizzati per etichettare un cavo come parte di una

rete elettrica, come "VCC" o "GND". Il comportamento delle porte di potenza è descritto nella sezione
collegamenti elettrici. I simboli di potenza vengono gestiti e creati allo stesso modo dei simboli normali, ma
ci sono diverse considerazioni aggiuntive descritte di seguito.

It may be useful to place power symbols in a dedicated library. KiCad’s symbol library places power symbols
in the power  library, and users may create libraries to store their own power symbols. If the "Define as
power symbol" box is checked in a symbol’s properties, that symbol will appear in the Schematic Editor’s
"Add Power Port" dialog for convenient access.

Di seguito è riportato un esempio di simbolo di potenza GND .
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Power port symbols consist of a pin of type "Power input" that is marked invisible. They must also have the

"Define as power symbol" property checked. Invisible power input pins have a special property of making
implicit global connections based on the pin name.

NOTE
Se il simbolo di potenza ha la proprietà "Definisci come simbolo di potenza" selezionata,
non è necessario contrassegnare il pin di ingresso di potenza come invisibile. Tuttavia, la
convenzione è di rendere comunque invisibili questi pin.
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Per creare un simbolo di potenza, seguire questi passi:

Aggiungi un pin di tipo "Ingresso potenza", con "Visibile" deselezionato e il nome del pin in base alla net
desiderata. Imposta il numero di pin a "1", la lunghezza a "0" e lo stile grafico su "Linea". Il nome del pin
stabilisce la connessione alla net; in questo caso il pin si collegherà automaticamente alla net GND . Il

numero di pin, la lunghezza e lo stile della linea non hanno rilevanza elettrica.

Posiziona il pin sull’ancora del simbolo.

Usa gli strumenti forma per disegnare la grafica del simbolo.

Set the symbol value. The symbol value does not matter electrically, but it is displayed in the schematic.
To eliminate confusion, it should match the pin name (which determines the connected net name).

Check the "Define as power symbol" box in Symbol Properties window. This makes the symbol appear in
the "Add Power Port" dialog, makes the Value  field read-only in the schematic, prevents the symbol
from being assigned a footprint, and excludes the symbol from the board, BOM, and netlists.

Impostare il simbolo di riferimento e deselezionare la casella "Mostra". Il testo di riferimento non è
importante ad eccezione del primo carattere, che dovrebbe essere # . Per la porta di potenza mostrata

sopra, il riferimento potrebbe essere "#GND". I simboli con riferimenti che iniziano con "#" non vengono
aggiunti al C.S., non sono inclusi nelle esportazioni della Distinta materiali o nelle netlist e non possono
essere assegnati a una impronta nello strumento di assegnazione impronte. Se il riferimento di una porta
di potenza non inizia con # , il carattere verrà inserito automaticamente quando veranno eseguiti gli

strumenti di annotazione o di assegnazione dell’impronta.
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Un metodo semplice per creare un nuovo simbolo di porta di potenza consiste nell’usare un altro simbolo
come punto di partenza, come descritto in precedenza.

NOTE

The connected net name is determined by the power port’s pin name, not
the name or
value of the symbol. When modifying an existing power port
 symbol, make sure to
rename the pin so that the new symbol connects to the
appropriate power net. This means
that power port net names can only be
changed in the symbol editor, not in the schematic.



101

Esploratore libreria di simboli
Introduzione
L’esploratore di librerie di simboli permette di scorrere velocemente il contenuto di una libreria di simboli.
È raggiungibile facendo clic sull’icona  sulla barra strumenti in alto, selezionando Visualizza →

Esploratore librerie di simboli, o facendo clic su Seleziona tramite browser nella finestra "Scegli
simbolo".
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Viewlib - schermo principale

Per esaminare i contenuti della libreria, selezionare la libreria desiderata dall’elenco sul lato sinistro. I

simboli disponibili appariranno nel secondo pannello. Selezionare il nome di un simbolo per visualizzarlo.
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Barra alta dell’esploratore delle librerie di simboli
La barra in alto dell’esploratore di librerie di simboli viene mostrata di seguito.

I comandi disponibili sono:

Selezione del simbolo che può essere selezionato anche nell’elenco
in mostra.

Mostra simbolo precedente.

Mostra simbolo successivo.

 
  Strumenti di zoom.

 Selezione della rappresentazione (normale o convertita) se una rappresentazione
alternativa esiste.

Selezione dell’unità per i simboli che contengono unità multiple.

Se esiste, mostra i documenti associati.

Chiude il browser e piazza il simbolo selezionato nello schema.
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Simulatore
KiCad incorpora un simulatore di circuiti elettronici che usa ngspice come motore di simulazione.

Quando si lavora con il simulatore, si può trovare utile la libreria ufficiale pspice. Essa contiene simboli
comuni usati per la simulazione come sorgenti di tensione o corrente, o transistor con pin numerati in modo
da corrispondere alle specifiche di ordine del nodo di ngspice.

Ci sono anche dei progetti dimostrativi per illustrare le capacità di simulazione. Si trovano nella cartella
demos/simulation.

Assegnazione modelli
Prima di avviare una simulazione, i componenti devono avere assegnato un modello Spice.

Ogni componente può avere solo un modello assegnato, anche se il componente consiste di più unità. In tal

caso, la prima unità deve specificare il modello.

I componenti passivi con riferimento all’accoppiamento di un tipo di dispositivo in notazione Spice (R* per
le resistenze, C* per i condensatori, L* per le induttanze) avranno modelli assegnati implicitamente e

useranno il campo valore per determinare le loro proprietà.

NOTE
Si faccia presente che nella notazione spice, 'M' sta per milli e 'Meg' per mega. Se si
preferisce usare 'M' per indicare il prefisso mega, è possibile indicarlo nella finestra di
dialogo delle impostazioni di simulazione.

Le informazioni sui modelli Spice sono memorizzate come testo nei campi dei simboli, perciò li si può

definire sia nell’editor dei simboli che in quello dello schema elettrico. Aprire la finestra di dialogo delle
proprietà del simbolo e fare clic sul pulsante Modifica modello Spice per aprire la finestra di dialogo
dell’editor del modello Spice.

La finestra di dialogo della modifica del modello Spice ha tre linguette corrispondenti a diversi tipi di

modello. Ci sono due opzioni comuni a tutti i tipi di modello:

http://ngspice.sourceforge.net/
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““

Disabilita simbolo per la
simulazione

Quando è abilitato il componente viene escluso dalla
simulazione.

Sequenza nodi alternativa Permette di imporre la mappatura nodi del modello ai pin del
simbolo.
 Per definire una mappatura diversa, specificare i

numeri dei pin nell’ordine che si aspetta il modello.

'Esempio:'


* connessioni: 


* 1: ingresso non-invertente 


* 2: ingresso invertente 


* 3: terminale positivo di potenza 


* 4: terminale negativo di potenza 


* 5: uscita 


.subckt tl071 1 2 3 4 5

Per accoppiare i pin del simbolo ai nodi del modello Spice
mostrati sopra, è necessario usare l’opzione sequenza di nodi
alternativa con valore: "1 3 5 2 4". È un elenco di numeri di pin
corrispondenti all’ordine dei nodi del modello Spice.

Passivo
La scheda Passivo permette all’utente di assegnare un modello di dispositivo passivo (resistore,

condensatore o induttore) ad un componente. È un’opzione usata raramente, dato che i componenti passivi
hanno modelli assegnati implicitamente, a meno che il riferimento del componente non corrisponda
all’effettivo tipo di dispositivo.

NOTE

I modelli di dispositivi passivi esplicitamente definiti hanno la priorità su quelli assegnati
implicitamente. Questo significa che una volta che un modello di dispositivo passivo
viene assegnato, i campi di riferimento e valore non sono presi in considerazione durante
la simulazione. Ciò può portare ad una situazione di confusione dove il valore del
modello assegnato non corrisponde con quello mostrato sullo schema elettrico.
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Tipo Seleziona il tipo di dispositivo (resistore, condensatore o

induttore).

Valore Definisce la proprietà del dispositivo (resistenza, capacità o

induttanza). Il valore può usare i soliti prefissi di unità di Spice
(come elencato sotto il campo di inserimento testo) e dovrebbe
usare il punto come separatore decimale. Si noti che Spice non

interpreta correttamente i prefissi inseriti nei valori (per es.
1k5).
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Modello
La scheda Modello viene usata per assegnare un semiconduttore o un modello complesso definito in un file
di libreria esterno. Le librerie del modello Spice vengono spesso fornite dal costruttore del dispositivo.

La finestra di testo principale mostra i contenuti del file di libreria selezionato. È pratica comune mettere la
descrizione del modello dentro i file delle librerie, includendo l’ordine dei nodi.
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File Percorso ad un file di libreria Spice. Questo file verrà usato dal
simulatore,
come viene aggiunto usando la direttiva .include.

Modello Il modello di dispositivo selezionato. Quando un file viene
selezionato, l’elenco viene riempito con i
modelli disponibili tra

cui scegliere.

Tipo Seleziona il tipo di modello (subcircuito, BJT, MOSFET o diodo).
Normalmente viene impostato
 automaticamente quando viene

selezionato un modello.

Sorgente
La scheda Sorgente viene usata per assegnare un modello di sorgente di potenza o di segnale. Ci sono due

sezioni: Analisi DC/AC e Analisi del transiente. Ognuna definisce i parametri sorgente per il tipo di
simulazione corrispondente.

L’opzione Tipo sorgente si applica a tutti i tipi di simulazione.
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Fare riferimento alla documentazione ngspice, capitolo 4 (Sorgenti di tensione e corrente) per ulteriori

dettagli sulle sorgenti.

Direttive Spice
È possibile aggiungere direttive Spice piazzandole nei campi di testo su un foglio dello schema. Questo
approccio torna comodo, per esempio, per la definizione del tipo di simulazione predefinita. Questa

funzionalità è limitata alle direttive Spice che cominciano con un punto (per es. '.tran 10n 1m'), e non è
possibile piazzare componenti aggiuntivi usando i campi di testo.

Simulazione
Per avviare una simulazione, aprire la finestra del Simulatore Spice selezionando il menu
Ispeziona→Simulatore nella finestra dell’editor degli schemi elettrici.

http://ngspice.sourceforge.net/docs/ngspice-27-manual.pdf
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La finesta è divisa in diverse sezioni:

Barra strumenti

Pannello grafici

Console di uscita

Elenco segnali

Elenco cursori

Pannello di regolazione

Menu

File
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Nuovo grafico Crea una nuova scheda nel pannello del grafico.

Apri libretto di lavoro Apre un elenco di segnali graficati.

Salva libretto di lavoro Salva un elenco di segnali graficati.

Salva come immagine Esporta il grafico attivo in un file .png .

Salva come file .csv Esporta i punti dei dati grezzi del grafico attivo in un file .csv .

Esci dalla simulazione Chiude la finestra di dialogo.

Simulazione

Avvia simulazione Esegue una simulazione usando le impostazioni correnti.

Aggiungi segnali…​ Apre una finestra di dialogo per selezionare i segnali da
graficare.

Campiona dallo schema Avvia lo strumento Sonda sullo schema elettrico.

Regola il valore dei
componenti

Avvia lo strumento Regola.

Mostra la netlist SPICE…​ Apre una finestra di dialogo che mostra la netlist generata per il
circuito simulato.

Impostazioni…​ Apre la finestra di dialogo delle impostazioni di simulazione.

Vista

Ingrandisci Ingrandisce il grafico attivo.

Rimpicciolisci Rimpicciolisce il grafico attivo.

Adatta allo schermo Regola l’ingrandimento per visualizzare tutto il grafico.

Mostra griglia Commuta la visibilità della griglia.

Mostra legenda Commuta la visibilità della legenda.

Barra strumenti

Questa barra strumenti dà accesso alle funzioni utilizzate più frequentemente.
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Avvia/Blocca Simulazione Avvia o blocca la simulazione.

Aggiungi segnali Apre una finestra di dialogo per selezionare i segnali da
graficare.

Sonda Avvia lo strumento Sonda sullo schema elettrico.

Regola Avvia lo strumento Regola sullo schema elettrico.

Impostazioni Apre la finestra delle impostazioni di simulazione.

Il pannello grafico
Visualizza i risultati della simulazione in forma di grafici. Si possono avere più grafici aperti in schede

separate ma solo quella attiva viene aggiornata quando viene eseguita una simulazione. In questo modo è
possibile confrontare i risultati di simulazione di esecuzioni diverse.

I grafici possono essere personalizzati abilitando o disabilitando la visibilità della griglia e della legenda
usando il menu Visualizza. Quando la legenda è visibile, questa può essere trascinata per cambiarne la

posizione.

Interazione del pannello del grafico:

la rotellina del mouse per ingrandire / rimpicciolire

clic destro per aprire il menu a scomparsa e regolare la visualizzazione

disegnare un rettangolo di selezione per fare lo zoom sull’area selezionata

trascinare un cursore per cambiarne le coordinate

Console d’uscita
La console d’uscita mostra i messsaggi generati dal simulatore. Si consigla di controllare sempre la console di
uscita per verificare che non ci siano errori o avvertenze.

Elenco segnali
Mostra l’elenco dei segnali mostrati nel grafico attivo.

Interazione elenco segnali:

click destro apre un menu contestuale che consente di nascondere il segnale o commutare il cursore

doppio clic per nascondere il segnale

Elenco cursori
Mostra l’elenco dei cursori e delle loro coordinate. Ogni segnale può avere un cursire visualizzato. La
visibilità dei cursori viene impostata usando l’elenco Segnali.

Pannello di regolazione
Mostra i componenti prelevati con lo strumento Regola. Il pannello Regola permette all’utente di modificare
velocemente i valori del componente e di osservare la loro influenza sui risultati della simulazione - ogni

volta che il valore di un componente viene cambiato, la simulazione viene riavviata e i grafici aggiornati.
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Per ogni componente ci sono alcuni controlli associati:

Il campo di testo in cima imposta il valore massimo del componente.

Il campo di testo di mezzo imposta il valore corrente del componente.

Il campo di testo in fondo imposta il valore minimo del componente.

Il cursore permette all’utente di modificare il valore del componente in modo agevole.

Il pulsante Salva modifica il valore del componente sullo schema al valore impostato con il cursore.

Il pulsante X rimuove il componente dal pannello di regolazione e ne ripristina il valore originale.

I tre campi di testo riconoscono i prefissi di unità Spice.

Strumento di regolazione
Lo strumento di regolazione permette all’utente di prelevare i componenti per regolarli.

Per selezionare un componente per la regolazione, fare clic su uno sullo schema con lo strumento attivo. I
componenti selezionati appariranno nel pannello Regola. Si possono regolare solo i componenti passivi.

Strumento sonda
Lo strumento sonda fornisce un modo semplice per selezionare i segnali da usare per i grafici.

Per aggiungere un segnale al grafico, fare clic su un filo corrispondete nell’editor dell schema elettrico
mentre lo strumento è attivo.
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Impostazioni di simulazione

La finestra di impostazione della simulazione permette all’utente di impostare il tipo e i parametri di
simulazione. Ci sono quattro schede:

AC

Trasferimento DC

Transiente

Personalizzato

Le prime tre schede forniscono dei moduli nei quali si possono specificare i parametri di simulazione.
L’ultima scheda permette all’utente di inserire direttive Spice personalizzate per impostare la simulazione. È
possibile trovare ulteriori informazioni sui tipi e sui parametri di simulazione nella documentazione
ngspice, capitolo 1.2.

Un modo alternativo per configurare una simulazione consiste nel battere le direttive Spice nei campi testo
nello schema. Ogni campo testo contenente una direttiva relativa ad un tipo di simulazione viene superata
dall’impostazione selezionata nella finestra di dialogo. Significa che una volta che si usa la finestra di dialogo

http://ngspice.sourceforge.net/docs/ngspice-27-manual.pdf
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di simulazione, la finestra di dialogo passa sopra alle direttive dello schema elettrico fino alla riapertura
della simulazione.

Ci sono due opzioni comuni a tutti i tipi di simulazione:

Regola i valori dei simboli
passivi

Rimpiazza i valori dei simboli passivi per convertire la notazione
dei valori dei componenti comuni alla notazione Spice.

Aggiungi il percorso
completo per la direttiva
di libreria .include

Antepone i nomi file delle librerie di modelli Spice con il
percorso completo. Normalmente ngspice richiede il percorso
completo per accedere ad un file di libreria.
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Argomenti avanzati
Configurazione e personalizzazione

NOTE DAFARE: scrivere questa sezione

Variabili di testo

NOTE DAFARE: scrivere questa sezione

Netlist e DIBA personalizzate
KiCad può generare netlist e DIBA in vari formati e gli utenti possono definire nuovi formati se lo
desiderano.

Il processo di esportazione di una netlist è descritto nella sezione esportazione netlist. Il risultato della DIBA
è descritto nella sezione esportazione DIBA.

La sezione seguente descrive come creare un esportatore per un nuovo formato di uscita.

Aggiunta di nuovi generatori di netlist
I nuovi generatori di netlist vengono aggiunti alla finestra di dialogo Esporta netlist facendo clic sul

pulsante Aggiungi generatore…​.

I nuovi generatori richiedono un nome e un comando. Il nome viene mostrato nell’etichetta della scheda e il

comando viene eseguito ogni volta che si fa clic sul pulsante Esporta netlist.

Quando viene generata la netlist, KiCad crea un file XML intermedio che contiene tutte le informazioni della
netlist dallo schema. In successione viene eseguito il comando generatore per trasformare la netlist

intermedia nel formato netlist desiderato.

Il comando netlist deve essere impostato correttamente in modo che lo script del generatore di netlist
prenda il file netlist intermedio come ingresso ed emetta il file netlist desiderato. L’esatto comando netlist
dipenderà dallo script generatore utilizzato. Il formato del comando è descritto di seguito.

Python e XSLT sono strumenti comunemente usati per creare generatori di netlist personalizzate.
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Aggiungere un nuovo generatore di DIBA
KiCad usa il file netlist intermedio anche per generare le distinte materiali con lo strumento generatore di
DIBA.

Ulteriori script possono essere aggiunti all’elenco degli script del generatore DIBA facendo clic sul pulsante 
. Gli script possono essere rimossi facendo clic sul pulsante . Il pulsante  apre lo script selezionato in

un editor di testo.

Gli script generatori in Python e XSLT possono contenere una intestazione di commento per descrivere

funzione e uso del generatore. Questa intestazione di commento viene visualizzata nella finestra di dialogo
DIBA come descrizione per ciascun generatore. L’intestazione di commento deve contenere la stringa
@package . Tutto ciò che segue quella stringa fino alla fine del commento viene usato come descrizione per il
generatore.

KiCad riempie automaticamente il campo della riga di comando quando viene aggiunto un nuovo script
generatore, ma potrebbe essere necessario regolare manualmente la riga di comando a seconda dello script.
KiCad tenta di determinare automaticamente l’estensione del file di output dalla riga di comando di esempio

nell’intestazione dello script generatore.
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Formato della linea di comando del generatore
La riga di comando per un esportatore di netlist o DIBA definisce il comando che KiCad eseguirà per
generare il file di uscita selezionato.

Per un esportatore di netlist che utilizza xsltproc , un esempio è:

xsltproc -o %O.net /usr/share/kicad/plugins/netlist_form_pads-pcb.asc.xsl %I

Per un esportatore DIBA che usa Python, un esempio è:

/usr/bin/python3 /usr/share/kicad/plugins/bom_csv_grouped_by_value.py "%I" "%O.csv"

NOTE Si consiglia di racchiudere gli argomenti nella riga di comando tra virgolette ( " ) nel caso
in cui contengano spazi o altri caratteri speciali.

Alcune sequenze di caratteri come %I  e %O  hanno un significato speciale nella riga di comando, dato che
KiCad le sostituisce con un nome file o un percorso prima di eseguire il comando.

Parametro Sostituito con…​ Descrizione

%I <percorso progetto>/<nome

progetto>.xml

Percorso assoluto e nome file del file netlist intermedio,
ingresso
del plug-in DIBA o del generatore di netlist

%O <percorso progetto>/<nome

progetto>

Percorso assoluto e nome file del file DIBA o netlist di
uscita (senza estensione
file). Potrebbe essere necessario
specificare un’estensione file appropriata dopo
la sequenza

%O.

%B <nome progetto> Nome file di base del file DIBA o netlist di uscita (senza
percorso o estensione
file). Potrebbe essere necessario
specificare un’estensione file appropriata dopo
la sequenza

%B.

%P <percorso progetto> Percorso assoluto della cartella del progetto, senza barra
finale.

File di netlist intermedio
Quando si esportano file DIBA e netlist, KiCad crea un file netlist intermedio e quindi esegue uno strumento
separato che post-elabora la netlist intermedia nel formato netlist o DIBA desiderato.

La netlist intermedia usa la sintassi XML. Essa contiene una grande quantità di dati sul progetto. A seconda
del risultato (distinta materiali o netlist), differenti sottoinsiemi dell’intero file di netlist intermedia saranno

inseriri nel file finale risultante.

La struttura del file della netlist intermedia è descritta in dettaglio sotto.

Poiché la conversione dal file della netlist intermedia alla netlist di uscita o DIBA è una trasformazione da
testo a testo, il filtro di post-elaborazione può essere scritto utilizzando Python, XSLT o qualsiasi altro

strumento in grado di accettare XML come ingresso.
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NOTE

XSLT non è raccomandato per nuovi esportatori di netlist o di DIBA; Meglio usare Python
o un altro strumento. A partire da KiCad 7, xsltproc  non è più installato con KiCad,
sebbene possa essere installato separatamente. Tuttavia, di seguito sono inclusi diversi
esempi di esportatori di netlist che usano XSLT.

Struttura netlist intermedia
Questo campione dà un’idea del formato del file netlist.
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<?xml version="1.0" encoding="utf-8"?>

<export version="D">

  <design>

    <source>F:\kicad_aux\netlist_test\netlist_test.sch</source>

    <date>29/08/2010 21:07:51</date>

    <tool>eeschema (2010-08-28 BZR 2458)-unstable</tool>

  </design>

  <components>

    <comp ref="P1">

      <value>CONN_4</value>

      <libsource lib="conn" part="CONN_4"/>

      <sheetpath names="/" tstamps="/"/>

      <tstamps>4C6E2141</tstamps>

    </comp>

    <comp ref="U2">

      <value>74LS74</value>

      <libsource lib="74xx" part="74LS74"/>

      <sheetpath names="/" tstamps="/"/>

      <tstamps>4C6E20BA</tstamps>

    </comp>

    <comp ref="U1">

      <value>74LS04</value>

      <libsource lib="74xx" part="74LS04"/>

      <sheetpath names="/" tstamps="/"/>

      <tstamps>4C6E20A6</tstamps>

    </comp>

    <comp ref="C1">

      <value>CP</value>

      <libsource lib="device" part="CP"/>

      <sheetpath names="/" tstamps="/"/>

      <tstamps>4C6E2094</tstamps>

    <comp ref="R1">

      <value>R</value>

      <libsource lib="device" part="R"/>

      <sheetpath names="/" tstamps="/"/>

      <tstamps>4C6E208A</tstamps>

    </comp>

  </components>

  <libparts/>

  <libraries/>

  <nets>

    <net code="1" name="GND">

      <node ref="U1" pin="7"/>

      <node ref="C1" pin="2"/>

      <node ref="U2" pin="7"/>

      <node ref="P1" pin="4"/>

    </net>

    <net code="2" name="VCC">

      <node ref="R1" pin="1"/>

      <node ref="U1" pin="14"/>

      <node ref="U2" pin="4"/>

      <node ref="U2" pin="1"/>

      <node ref="U2" pin="14"/>

      <node ref="P1" pin="1"/>

    </net>

    <net code="3" name="">

      <node ref="U2" pin="6"/>

    </net>

    <net code="4" name="">

      <node ref="U1" pin="2"/>
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Struttura generale del file netlist
La netlist intermedia consta di cinque sezioni.

La sezione intestazione.

La sezione componenti.

La sezione librerie di parti.

La sezione librerie.

La sezione collegamenti.

Il contenuto del file ha il delimitatore <export>

Sezione intestazione
L’intestazione ha il delimitatore <design>

Questa sezione può essere considerata una sezione di commento.

La sezione componenti
La sezione componenti ha il delimitatore <components>

Questa sezione contiene l’elenco componenti dello schema. Ogni componente viene descritto in questo
modo:

<export version="D">

...

</export>

<design>

<source>F:\kicad_aux\netlist_test\netlist_test.sch</source>

<date>21/08/2010 08:12:08</date>

<tool>eeschema (2010-08-09 BZR 2439)-unstable</tool>

</design>

<components>

<comp ref="P1">

<value>CONN_4</value>

<libsource lib="conn" part="CONN_4"/>

<sheetpath names="/" tstamps="/"/>

<tstamps>4C6E2141</tstamps>

</comp>

</components>
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Nome elemento Descrizione elemento

libsource nome della lib dove questo componente è stato trovato.

part nome componente dentro questa libreria.

sheetpath percorso del foglio dentro la gerarchia: identifica il foglio
dentro
la gerarchia generale dello schema.

tstamps marcatura temporale del componente.

Nota sulle marcature temporali per i componenti

Per identificare un componente in una netlist e quindi in una scheda, la marcatura temporale viene usata
come riferimento univoco per ogni componente. Comunque KiCad fornisce un modo alternativo per
identificare il corrispondente componente di una impronta sulla scheda. Ciò permette la ri-annotazione di

componenti in un progetto di schema elettrico non perdendo il collegamento tra il componente e la sua
impronta.

Un marcatore temporale è un identificatore univoco per ogni componente o foglio in un progetto di schema
elettrico. Ma in caso di gerarchie complesse, lo stesso foglio viene usato più di una volta, perciò il foglio

contiene componenti aventi la stessa marcatura temporale.

Un dato foglio dentro una gerarchia complessa possiede un identificatore univoco: il suo percorso foglio. Un
dato componente (dentro una gerarchia complessa) possiede un identificativo univoco: il percorso foglio +
la sua marcatura temporale.

La sezione libparts
La sezione libparts ha un delimitatore <libparts> , e il contenuto di questa sezione viene definito nelle

librerie degli schemi.

<comp ref="P1">

<value>CONN_4</value>

<libsource lib="conn" part="CONN_4"/>

<sheetpath names="/" tstamps="/"/>

<tstamps>4C6E2141</tstamps>

</comp>
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Nome elemento Descrizione elemento

<footprints> I filtri impronte del simbolo. Ogni filtro impronta

si trova in un marcatore <fp> separato.

<fields> I campi del simbolo. Il nome e il valore di ciascun

campo sono dati in un marcatore `<field
name="nomecampo">…​</field> separato.

<pins> I pin del simbolo. Ogni pin è fornito in un

marcatore <pin num="num_pin"
type="tipo_pin"/> separato. I tipi di pin possibili
sono descritti di seguito.

Tipi elettrici dei pin possibili sono:

<libparts>

<libpart lib="device" part="CP">

  <description>Condensatore polarizzato</description>

  <footprints>

    <fp>CP*</fp>

    <fp>SM*</fp>

  </footprints>

  <fields>

    <field name="Riferimento">C</field>

    <field name="Valore">CP</field>

  </fields>

  <pins>

    <pin num="1" name="1" type="passive"/>

    <pin num="2" name="2" type="passive"/>

  </pins>

</libpart>

</libparts>
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Tipopin Descrizione

Input Normale pin di ingresso

Output Normale pin di uscita

Bidirectional Ingresso o uscita

Tri-state Bus ingresso/uscita

Passive Normale capo di componente passivo

Unspecified Tipo elettrico sconosciuto

Power input Ingresso di potenza, per es. l’alimentazione di un componente

Power output Uscita di potenza, per es. l’uscita di regolatore di tensione

Open collector Collettore aperto, comune dei comparatori analogici

Open emitter Emettitore aperto, presente in alcuni circuiti logici

Not connected Deve essere lasciato aperto nello schema elettrico

La sezione librerie
La sezione librerie possiede il delimitatore <libraries> . Questa sezione contiene l’elenco delle librerie di
schemi elettrici usate nel progetto.

La sezione collegamenti
La sezione net possiede il delimitatore <nets> . Questa sezione contiene le connessioni dello schema

elettrico elencando tutte le net e i pin connessi ad esse.

<libraries>

  <library logical="device">

    <uri>F:\kicad\share\library\device.lib</uri>

  </library>

  <library logical="conn">

    <uri>F:\kicad\share\library\conn.lib</uri>

  </library>

</libraries>
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Un tipico collegamento contiene i seguenti elementi.

Nome
elemento

Descrizione elemento

net code un identificatore interno per questa net

name il nome collegamento

node il piedino (identificato da pin ) di un simbolo (identificato da

ref ) connesso alla net

Esportatori di netlist di esempio
Alcuni esportatori di netlist di esempio che usano XSLT sono inclusi sotto.

XSLT è di per sè un linguaggio XML molto adatto alle trasformazioni XML. Il programma xsltproc  può
essere usato per leggere in ingresso il file XML di netlist intermedio, applicare un foglio di stile per

trasformare l’ingresso, e salvare il risultato in un file in uscita. L’uso di xsltproc  richiede un file foglio di
stile che usi le convenzioni XSLT. L’intero processo di conversione viene gestito da KiCad, dopo essere stato
configurato per l’esecuzione di xsltproc  in modo specifico.

Il documento che descrive le trasformazioni XSL (XSLT) è disponibile qui: http://www.w3.org/TR/xslt

NOTE Quando si sta scrivendo un nuovo esportatore di netlist, si consiglia di prendere in
considerazione l’uso di Python o di un altro linguaggio ad alto livello al posto di XSLT.

<nets>

  <net code="1" name="GND">

    <node ref="U1" pin="7"/>

    <node ref="C1" pin="2"/>

    <node ref="U2" pin="7"/>

    <node ref="P1" pin="4"/>

  </net>

  <net code="2" name="VCC">

    <node ref="R1" pin="1"/>

    <node ref="U1" pin="14"/>

    <node ref="U2" pin="4"/>

    <node ref="U2" pin="1"/>

    <node ref="U2" pin="14"/>

    <node ref="P1" pin="1"/>

  </net>

</nets>

<net code="1" name="GND">

  <node ref="U1" pin="7"/>

  <node ref="C1" pin="2"/>

  <node ref="U2" pin="7"/>

  <node ref="P1" pin="4"/>

</net>

http://xmlsoft.org/XSLT/xsltproc.html
http://www.w3.org/TR/xslt
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Esempio di netlist PADS usando XSLT
L’esempio seguente mostra come creare un esportatore per il formato netlist PADS utilizzando xlstproc .

Il formato netlist di PADS è formato da due sezioni:

Un elenco di impronte

Un elenco di net, assieme con le piazzole connesse ad ogni net.

Immediatamente di seguito c’è un foglio di stile XSL che converte il file di netlist intermedio in formato

netlist PADS.
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<?xml version="1.0" encoding="ISO-8859-1"?>

<!--XSL style sheet to Eeschema Generic Netlist Format to PADS netlist format

    Copyright (C) 2010, SoftPLC Corporation.

    GPL v2.



    How to use:

        https://lists.launchpad.net/kicad-developers/msg05157.html

-->



<!DOCTYPE xsl:stylesheet [

  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF -->

]>



<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:output method="text" omit-xml-declaration="yes" indent="no"/>



<xsl:template match="/export">

    <xsl:text>*PADS-PCB*&nl;*PART*&nl;</xsl:text>

    <xsl:apply-templates select="components/comp"/>

    <xsl:text>&nl;*NET*&nl;</xsl:text>

    <xsl:apply-templates select="nets/net"/>

    <xsl:text>*END*&nl;</xsl:text>

</xsl:template>



<!-- per ogni componente -->

<xsl:template match="comp">

    <xsl:text> </xsl:text>

    <xsl:value-of select="@ref"/>

    <xsl:text> </xsl:text>

    <xsl:choose>

        <xsl:when test = "footprint != '' ">

            <xsl:apply-templates select="footprint"/>

        </xsl:when>

        <xsl:otherwise>

            <xsl:text>unknown</xsl:text>

        </xsl:otherwise>

    </xsl:choose>

    <xsl:text>&nl;</xsl:text>

</xsl:template>



<!-- per ogni net -->

<xsl:template match="net">

    <!-- nets are output only if there is more than one pin in net -->

    <xsl:if test="count(node)>1">

        <xsl:text>*SIGNAL* </xsl:text>

        <xsl:choose>

            <xsl:when test = "@name != '' ">

                <xsl:value-of select="@name"/>

            </xsl:when>

            <xsl:otherwise>

                <xsl:text>N-</xsl:text>

                <xsl:value-of select="@code"/>

            </xsl:otherwise>

        </xsl:choose>

        <xsl:text>&nl;</xsl:text>

        <xsl:apply-templates select="node"/>

    </xsl:if>

</xsl:template>



<!-- per ogni nodo -->
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Ed ecco il file netlist PADS in uscita dopo l’esecuzione di xsltproc :

La riga di comando per effettuare questa conversione è:

kicad\\bin\\xsltproc.exe -o test.net kicad\\bin\\plugins\\netlist_form_pads-pcb.xsl test.tmp

Esempio di netlist Cadstar usando XSLT
L’esempio seguente mostra come creare un esportatore per il formato netlist Cadstar usando xlstproc .

Il formato Cadstar è formato da due sezioni:

L’elenco impronte

La netslist: raggruppando riferimenti a piazzole per collegamenti

Di seguito c’è un foglio di stile XSL che converte il file di netlist intermedio in formato netlist Cadstar.

*PADS-PCB*

*PART*

P1 unknown

U2 unknown

U1 unknown

C1 unknown

R1 unknown

*NET*

*SIGNAL* GND

U1.7

C1.2

U2.7

P1.4

*SIGNAL* VCC

R1.1

U1.14

U2.4

U2.1

U2.14

P1.1

*SIGNAL* N-4

U1.2

U2.3

*SIGNAL* /SIG_OUT

P1.2

U2.5

U2.2

*SIGNAL* /CLOCK_IN

R1.2

C1.1

U1.1

P1.3



*END*
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<?xml version="1.0" encoding="ISO-8859-1"?>

<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format

    Copyright (C) 2010, Jean-Pierre Charras.

    Copyright (C) 2010, SoftPLC Corporation.

    GPL v2. -->



<!DOCTYPE xsl:stylesheet [

  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF -->

]>



<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:output method="text" omit-xml-declaration="yes" indent="no"/>



<!-- Netlist header -->

<xsl:template match="/export">

    <xsl:text>.HEA&nl;</xsl:text>

    <xsl:apply-templates select="design/date"/>  <!-- Generate line .TIM <time> -->

    <xsl:apply-templates select="design/tool"/>  <!-- Generate line .APP <eeschema version> 
-->

    <xsl:apply-templates select="components/comp"/>  <!-- Generate list of components -->

    <xsl:text>&nl;&nl;</xsl:text>

    <xsl:apply-templates select="nets/net"/>          <!-- Generate list of nets and 
connections -->

    <xsl:text>&nl;.END&nl;</xsl:text>

</xsl:template>



 <!-- Generate line .TIM 20/08/2010 10:45:33 -->

<xsl:template match="tool">

    <xsl:text>.APP "</xsl:text>

    <xsl:apply-templates/>

    <xsl:text>"&nl;</xsl:text>

</xsl:template>



 <!-- Generate line .APP "eeschema (2010-08-17 BZR 2450)-unstable" -->

<xsl:template match="date">

    <xsl:text>.TIM </xsl:text>

    <xsl:apply-templates/>

    <xsl:text>&nl;</xsl:text>

</xsl:template>



<!-- for each component -->

<xsl:template match="comp">

    <xsl:text>.ADD_COM </xsl:text>

    <xsl:value-of select="@ref"/>

    <xsl:text> </xsl:text>

    <xsl:choose>

        <xsl:when test = "value != '' ">

            <xsl:text>"</xsl:text> <xsl:apply-templates select="value"/> <xsl:text>"
</xsl:text>

        </xsl:when>

        <xsl:otherwise>

            <xsl:text>""</xsl:text>

        </xsl:otherwise>

    </xsl:choose>

    <xsl:text>&nl;</xsl:text>

</xsl:template>



<!-- for each net -->

<xsl:template match="net">

    <!-- nets are output only if there is more than one pin in net -->
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Ecco il file Cadstar in uscita.

Esempio di netlist di OrcadPCB2 che usa XSLT
Questo formato ha solo una sezione che consiste nell’elenco impronte. Ogni impronta include un elenco
piazzole con un riferimento ad una connessione.

Di seguito c’è un foglio di stile XSL che converte il file di netlist intermedio in formato netlist Orcad.

.HEA


.TIM 21/08/2010 08:12:08


.APP "eeschema (2010-08-09 BZR 2439)-unstable"


.ADD_COM P1 "CONN_4"


.ADD_COM U2 "74LS74"


.ADD_COM U1 "74LS04"


.ADD_COM C1 "CP"


.ADD_COM R1 "R"





.ADD_TER U1.7 "GND"

.TER     C1.2

         U2.7

         P1.4

.ADD_TER R1.1 "VCC"

.TER     U1.14

         U2.4

         U2.1

         U2.14

         P1.1

.ADD_TER U1.2 "N-4"

.TER     U2.3

.ADD_TER P1.2 "/SIG_OUT"

.TER     U2.5

         U2.2

.ADD_TER R1.2 "/CLOCK_IN"

.TER     C1.1

         U1.1

         P1.3



.END
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<?xml version="1.0" encoding="ISO-8859-1"?>

<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format

    Copyright (C) 2010, SoftPLC Corporation.

    GPL v2.



    How to use:

        https://lists.launchpad.net/kicad-developers/msg05157.html

-->



<!DOCTYPE xsl:stylesheet [

  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF -->

]>



<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:output method="text" omit-xml-declaration="yes" indent="no"/>



<!--

    Netlist header

    Creates the entire netlist

    (can be seen as equivalent to main function in C

-->

<xsl:template match="/export">

    <xsl:text>( { Eeschema Netlist Version 1.1  </xsl:text>

    <!-- Generate line .TIM <time> -->

<xsl:apply-templates select="design/date"/>

<!-- Generate line eeschema version ... -->

<xsl:apply-templates select="design/tool"/>

<xsl:text>}&nl;</xsl:text>



<!-- Generate the list of components -->

<xsl:apply-templates select="components/comp"/>  <!-- Generate list of components -->



<!-- end of file -->

<xsl:text>)&nl;*&nl;</xsl:text>

</xsl:template>



<!--

    Generate id in header like "eeschema (2010-08-17 BZR 2450)-unstable"

-->

<xsl:template match="tool">

    <xsl:apply-templates/>

</xsl:template>



<!--

    Generate date in header like "20/08/2010 10:45:33"

-->

<xsl:template match="date">

    <xsl:apply-templates/>

    <xsl:text>&nl;</xsl:text>

</xsl:template>



<!--

    This template read each component

    (path = /export/components/comp)

    creates lines:

     ( 3EBF7DBD $noname U1 74LS125

      ... pin list ...

      )

    and calls "create_pin_list" template to build the pin list

-->
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Ecco il file OrcadPCB2 risultante.

( { Eeschema Netlist Version 1.1  29/08/2010 21:07:51

eeschema (2010-08-28 BZR 2458)-unstable}

 ( 4C6E2141 $noname P1 CONN_4

  (  1 VCC )

  (  2 /SIG_OUT )

  (  3 /CLOCK_IN )

  (  4 GND )

 )

 ( 4C6E20BA $noname U2 74LS74

  (  1 VCC )

  (  2 /SIG_OUT )

  (  3 N-04 )

  (  4 VCC )

  (  5 /SIG_OUT )

  (  6 ? )

  (  7 GND )

  (  14 VCC )

 )

 ( 4C6E20A6 $noname U1 74LS04

  (  1 /CLOCK_IN )

  (  2 N-04 )

  (  7 GND )

  (  14 VCC )

 )

 ( 4C6E2094 $noname C1 CP

  (  1 /CLOCK_IN )

  (  2 GND )

 )

 ( 4C6E208A $noname R1 R

  (  1 VCC )

  (  2 /CLOCK_IN )

 )

)

*
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Riferimento azioni
Di seguito è riportato un elenco di ogni azione disponibile nell’editor degli schemi elettrici di KiCad: un
comando che può essere assegnato a un tasto comando.

Editor degli schemi elettrici
Le azioni seguenti sono disponibili nell’editor degli schemi elettrici. I tasti di scelta rapida possono essere
assegnati a una qualsiasi di queste azioni nella sezione Tasti comando delle preferenze.

Azione Tasto
comando
predefinito

Descrizione

Allinea elementi
alla griglia

Annota schema…​ Compila i riferimenti dei simboli nello schema

Assegna
impronte…​

Esegui lo strumento di assegnamento impronte

Cancella
evidenziazioni
collegamenti

Cancella ogni evidenziazione collegamenti

Esporta grafica
negli appunti

Esporta la grafica del foglio corrente negli appunti

Modifica simbolo
di libreria…​

+
+

Apri il simbolo di libreria nell’editor dei simboli

Modifica numero
pagina…​

Modifica il numero pagina del foglio corrente o selezionato

Modifica i campi
dei simboli…​

Modifica in blocco i campi di tutti i simboli nello schema elettrico

Modifica i
collegamenti alle
librerie di
simboli…​

Modifica i collegamenti tra i simboli dello schema e della libreria

Modifica con
l’editor dei simboli

+ Apri il simbolo selezionato nell’editor dei simboli

Evidenzia sul C.S. Evidenzia gli elementi corrispondenti nell’editor del C.S.

Esporta la netlist…​ Esporta il file contenente la netlist in diversi formati

Forza fili e bus
Or./Vert.

Commuta la modalità O e V per i nuovi fili e bus

~

Ctrl Maiusc

E

Ctrl E
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Azione Tasto
comando
predefinito

Descrizione

Genera DIBA…​ Genera una distinta materiali per lo schema corrente

Evidenzia
collegamento

Evidenzia il collegamento sotto il puntatore

Evidenzia
collegamenti

Evidenzia fili e pin di un collegamento

Importa
assegnamenti
impronte…​

Import symbol footprint assignments from .cmp file created by
Pcbnew

Rimappa simboli
obsoleti di
libreria…​

Rimappa i riferimenti ai simboli di libreria nel vecchio schema alla
tabella libreria di simboli

Ripara schema
elettrico

Esegue varie diagnostiche e cerca di riparare lo schema elettrico

Recupera
simboli…​

Trova i vecchi simboli in un progetto e li rinomina/recupera

Simulatore…​ Simula il circuito in SPICE

Salva la copia del
foglio corrente
come…​

Salva una copia del foglio corrente in un’altra posizione o nome

Impostazioni dello
schema…​

Modifica le impostazioni schema inclusi gli stili di annotazione e le
regole elettriche

Definizioni bus…​ Gestisci le definizioni dei bus

Mostra campi
nascosti

Commuta la visualizzazione dei campi di testo nascosti

Mostra pin
nascosti

Commuta la visualizzazione dei pin nascosti

Passa all’editor del
C.S.

Apri il C.S. nell’editor

Console di script Mostra/nascondi la console degli script

Controllo simboli Mostra la finestra del controllo simboli

Controllo regole
elettriche (ERC)

Esegui il controllo regole elettriche

Mostra Datasheet Apre il datasheet in un browser

`

D
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Azione Tasto
comando
predefinito

Descrizione

Aggiungi etichetta
gerarchica

Aggiungi etichetta gerarchica

Aggiungi
immagine

Aggiungi immagine bitmap

Aggiungi
giunzione

Aggiungi una giunzione

Aggiungi etichetta Aggiungi una etichetta di connessione

Aggiungi
indicatore di non
connessione

Aggiungi un indicatore di non connesso

Aggiungi potenza Aggiungi una porta di potenza

Aggiungi testo Aggiungi testo

Aggiungi simbolo Aggiungi un simbolo

Aggiungi giunzioni
alla selezione
dove servono

Aggiungi bus Aggiungi un bus

Aaggiungi linee Aggiungi linee grafiche connesse

Aggiungi filo Aggiungi un filo

Fine filo o bus Completa il disegno del segmento corrente

Termina bus Completa il bus con il segmento corrente

Termina fili Completa la connessione dei fili con il segmento corrente

Termina filo Completa il filo con il segmento corrente

Dispiega dal bus Aggiungi un filo ad un elemento bus

Assegna netclass…​ Assegna una netclass al collegamento del filo selezionato

Autopiazza campi Esegue l’algoritmo di disposizione automatica sul simbolo o sui
campi del simbolo

Interrompi bus Divide un bus in segmenti che possono venire trascinati
indipendentemente

Interrompi filo Divide un filo in segmenti che possono venire trascinati
indipendentemente

H

J

L

Q

P

T

A

B

I

W

K

C

O
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Azione Tasto
comando
predefinito

Descrizione

Modifica proprietà
tesi e grafiche…​

Modifica proprietà testi e grafiche globalmente nello schema

Modifica valore…​ Mostra la finestra del campo valore

Ribalta
orizzontalmente

Scambia gli elementi selezionati da destra a sinistra

Ribalta
verticalmente

Scambia gli elementi selezionati da cima a fondo

Tabella pin…​ Mostra la tabella pin per la modifica in blocco

Proprietà…​ Mostra la finestra delle proprietà dell’elemento

Ripeti l’ultimo
elemento

Duplicate l’ultimo elemento disegnato

Ruota in senso
antiorario

Ruota gli elementi selezionati in senso antiorario

Ruota in senso
orario

Ruota gli elementi selezionati in senso orario

De Morgan
alternativa

Passa alla rappresentazione De Morgan alternativa

De Morgan
standard

Passa alla rappresentazione De Morgan standard

Proprietà
simbolo…​

Mostra la finestra delle proprietà del simbolo

Cambia in
etichetta globale

Cambia l’elemento esistente in etichetta globale

Cambia in
etichetta
gerarchica

Cambia l’elemento esistente in etichetta gerarchica

Cambia in
etichetta

Cambia l’elemento esistente in etichetta

Cambia in testo Cambia l’elemento esistente in testo di commento

Conversione De
Morgan

Commuta tra rappresentazioni De Morgan

Aggiorna
simbolo…​

Aggiorna simbolo per includere qualunque cambiamento dalla
libreria

V

X

Y

E

Ins

R
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Azione Tasto
comando
predefinito

Descrizione

Naviga alla pagina Naviga alla pagina

Esci dal foglio + Mostra il foglio genitore nella finestra dell’editor degli schemi

Navigatore
gerarchia

Mostra la gerarchia degli schemi

Replica lunghezza
pin

Copia la lunghezza pin su altri pin nel simbolo

Replica
dimensione nome
pin

Copia la dimensione nome pin su altri pin nel simbolo

Replica
dimensione
numero pin

Copia la dimensione numero pin su altri pin nel simbolo

Crea vertice Crea un vertice

Elimina vertice Elimina vertice

Aggiungi una
sonda simulatore

Seleziona un
parametro da
regolare

Aggiungi arco Aggiungi un arco

Aggiungi cerchio Aggiungi un cerchio

Aggiungi linee Aggiungi linee grafiche connesse

Aggiungi
rettangolo

Aggiungi un rettangolo

Termina grafica Termina il disegno della forma grafica

Sposta àncora
simbolo

Specifica una nuova posizione per l’àncora del simbolo

Aggiungi pin Aggiungi un pin

Aggiungi testo Aggiungi un elemento di testo

Aggiungi simbolo
allo schema

Aggiungi simbolo allo schema

Copia

Alt Back

P
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Azione Tasto
comando
predefinito

Descrizione

Nascondi albero
dei simboli

Importa simbolo…​ Importa un simbolo nella libreria corrente

Nuovo simbolo…​ Crea un nuovo simbolo

Incolla simbolo

Salva libreria
come…​

+ + Salva la libreria corrente in un nuovo file.

Salva come…​ Salva il simbolo corrente in una diversa libreria.

Mostra tipi
elettrici pin

Annota i pin con i loro tipi elettrici

Mostra albero dei
simboli

Modalità modifica
pin sincronizzati

Modalità modifica pin sincronizzati
Propaga ad altre unità tutti i
cambiamenti (eccetto la numerazione dei pin).
Abilitata come
impostazione predefinita per le parti multiunità con unità
interscambiabili.

Aggiorna campi
simboli…​

Aggiorna il simbolo per far corrispondere i cambiamenti fatti nel
simbolo genitor

Spostamento
simbolo attiva

Comuni
Le azioni seguenti sono disponibili in KiCad, incluso nell’editor degli schemi. I tasti comando possono essere
assegnati a una qualsiasi di queste azioni nella sezione Tasti comando delle preferenze.

Azione Tasto
comando
predefinito

Dscrizione

Escludi marcatore Marca la violazione corrente nella finestra di controllo come
esclusione

N

Ctrl Shift

S
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Azione Tasto
comando
predefinito

Dscrizione

Marcatore
successivo

Vai al marcatore successivo nella finestra di controllo

Marcatore
precedente

Vai al marcatore precedente nella finestra di controllo

Aggiungi libreria…​ Aggiungi una cartella libreria esistente

Clic Esegue il clic del tasto sinistro del mouse

Doppio-clic Esegue il doppio clic del tasto sinistro del mouse

Puntatore giù

Puntatore giù
veloce

+

Puntatore sinistra

Puntatore sinistra
veloce

+

Puntatore destra

Puntatore destra
veloce

+

Puntatore su

Puntatore su
veloce

+

Passa a griglia
veloce 1

+

Passa a griglia
veloce 2

+

Passa a griglia
successiva

Passa a griglia
precedente

+

Proprietà griglia…​ Imposta dimensioni griglia

Reimposta origine
griglia

Origine griglia Imposta il punto origine della griglia

Return

End

Down

Ctrl Down

Left

Ctrl Left

Right

Ctrl Right

Up

Ctrl Up

Alt 1

Alt 2

N

Shift N

Z

S
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Azione Tasto
comando
predefinito

Dscrizione

Nuova libreria…​ Crea una nuova cartella libreria

Apri…​ + Apri documento esistente

Impostazioni
pagina…​

Impostazioni dimensioni pagina e informazioni del riquadro
iscrizioni

Pan basso +

Pan sinistra +

Pan destra +

Pan alto +

Blocca libreria Mantieni la libreria in cima all’elenco

Traccia…​ Traccia

Stampa…​ + Stampa

Esci Chiudi l’editor corrente

Azzera coordinate
locali

Ripristina Annulla i cambiamenti

Salva + Salva i cambiamenti

Salva tutto Salva tutti i cambiamenti

Salva come…​ + + Salva il documento corrente in un’altra posizione

Salva copia come…​ Salva una copia del documento corrente in un’altra posizione

Visualizzatore 3D + Mostra la finestra di visualizzazione 3D

Mostra menu
contestuale

Esegue l’azione del tasto destro del mouse

Esploratore
librerie di
impronte

Esplora le librerie di impronte

Editor impronte Crea, cancella e modifica le impronte

Esploratore
librerie di simboli

Esplora le librerie di simboli

Ctrl O

Shift Down

Shift Left

Shift Right

Shift Up

Ctrl P

Space

Ctrl S

Ctrl Shift

S

Alt 3
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Azione Tasto
comando
predefinito

Dscrizione

Mostra griglia Mostra i punti o le linee della griglia nella finestra di modifica

Coordinate polari Commuta tra i sistemi di coordinate polare e cartesiano

Commuta unità + Commuta tra unità imperiali e metriche

Sblocca libreria Non mantenere più la libreria in cima all’elenco

Aggiorna il C.S.
dallo schema…​

Aggiorna il C.S. con i cambiamenti effettuati sullo schema

Aggiorna lo
schema dal C.S. …​

Aggiorna lo schema con i cambiamenti effettuati sul C.S.

Centra Centra

Zoom agli oggetti + Zoom agli oggetti

Adatta zoom Adatta zoom

Ingrandisci al
puntatore

Ingrandisci al puntatore

Ingrandisci Ingrandisci

Rimpicciolisci al
puntatore

Rimpicciolisci al puntatore

Rimpicciolisci Rimpicciolisci

Aggiorna Aggiorna

Zoom alla
selezione

+ Zoom alla selezione

Annulla Annulla strumento corrente

Cambia metodo di
modifica

+ Cambia i vincoli del metodo di modifica

Copia + Copia gli elementi selezionati sugli appunti

Taglia + Taglia gli elementi selezionati sugli appunti

Cancella Elimina gli elementi selezionati

Strumento di
cancellazione
interattivo

Elimina gli elementi con il clic

Duplica + Duplica gli elementi selezionati

Ctrl U

F8

F4

Ctrl Home

Home

F1

F2

F5

Ctrl F5

Ctrl Space

Ctrl C

Ctrl X

Del

Ctrl D
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Azione Tasto
comando
predefinito

Dscrizione

Trova il prossimo
marcatore

+

Incolla + Incolla gli elementi dagli appunti

Incolla speciale…​ Incolla gli elementi dagli appunti con opzioni

Rifà + Rifà l’ultima modifica

Rimpiazza tutto Rimpiazza tutte le corrispondenze

Rimpiazza e trova
il prossimo

Rimpiazza la corrispondenza corrente e trova la prossima

Seleziona tutto + Seleziona tutti gli elementi sullo schermo

Annulla + Annulla l’ultima modifica

Strumento di
misura

+ + Misura interattivamente distanze tra punti

Seleziona elementi Seleziona elementi

Configura
percorsi…​

Modifica i percorsi delle variabili ambiente

Donazioni Apri "Donazioni per KiCad" in un browser webr

Collabora con noi Apri "Contribuire a KiCad" in un browser web

Introduzione a
KiCad

Apri "Introduzione a KiCad", guida introduttiva

Aiuto Apri la documentazione del prodotto in un browser web

Elenco tasti…​ + Mostra l’elenco dei tasti corrente e dei comandi corrispondenti

Preferenze…​ + Mostra preferenze per tutti gli strumenti aperti

Segnala bug Segnala un problema di KiCad

Gestione librerie
impronte…​

Modifica gli elenchi librerie di impronte globale e di progetto

Gestione librerie
simboli…​

Modifica gli elenchi librerie di simboli globale e di progetto

Shift F3

Ctrl V

Ctrl Y

Ctrl A

Ctrl Z

Ctrl Shift

M

Ctrl F1

Ctrl ,
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